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Chapter 1 – Introduction 
 
Introduction 
Thank you for choosing Docs2Manage, which was created to securely store and effectively 
manage virtually any type of document into a searchable database.  Documents can be added to 
the system via a scanner or from any type of existing file.  Multiple files can even be drag-and-
dropped into Docs2Manage to import files in volume in just a few clicks.  Documents are stored in 
a compressed format into a database or file structure - saving as much as 90% less disk space 
than the original files outside of the system. 
 
Docs2Manage also supports cloud databases like Microsoft Azure SQL and file cloud storage like 
Dropbox that help make your document management system portable.   
 
If you need to access Docs2Manage from any web browser or on your mobile devices, the 
optional Docs2Web software helps serve your documents securely to any web browser. 
 
Docs2Manage can back-up all your documents or results of a search to portable media called 
Docs2Go Archives by creating a "snapshot" of the database and documents, which can be 
copied and even burned to a CD/DVD from inside Docs2Manage (you must have a CD/DVD 
Burner to use this feature).  These can be distributed royalty free and run on any Windows 
machine without the need for an install process or purchasing an additional Docs2Manage 
licenses.  You can even design your own splash screen so the distribution CD/DVD will run 
looking like your own company's creation. 
 
Within Docs2Manage, documents can have an unlimited amount of descriptive information added 
or use the included OCR plug-in to extract keywords from the documents to make searching by 
keywords more powerful.  The new Document Explorer interface allows a graphical means to 
search for documents like Windows Explorer.   
 
The annotations feature allows the user to add comments on a separate layer than the document. 
 
The security in Docs2Manage has been enhanced to audit and track each user who has access.  
By supporting multiple departments in a single database, Docs2Manage allows each user or 
defined departments to customize the data fields and user rights/roles to each department to 
prevent information breaches to unauthorized users.  Docs2Manage also supports document 
locking to prevent others from editing certain documents and provide added security.  
 
The repository mode provides for high-speed scanning of unorganized documents, which can 
later be organized and categorized to increase workflow speed.  This also allows incoming 
documents to be divided based on workflow or job function. 
 
Docs2Manage also has internationalization support which allows the ability to change the 
language used by Docs2Manage to one of ten other languages.  There is even the ability to add 
your own language if it is not already supported by Docs2Manage. 
 
Docs2Manage has been developed to be easy to use for personal/home applications and 
powerfully enough for the large multi-department organization.  Docs2Manage can accommodate 
when you want to upgrade your database from an MS Access database to an enterprise 
database like MS SQL Server, MySQL, Oracle, InterBase, IBM DB2 or Sybase. 
 
As you will see, Docs2Manage has a user-friendly interface but includes an extensive help file for 

http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/cgi-bin/d2mweb.dll/ProdD2W
http://www.docs2manage.com/cgi-bin/d2mweb.dll/ProdD2W
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your review.  Docs2Manage is functional and powerful enough to be the right solution for your 
document management needs today and in the future. 
 
Please note that Docs2Manage is not free software.  
 
You may try out the unregistered version of Docs2Manage without any charge on a trial basis for 
60 days or till you hit the 5,000 document pages limit.  After that point you will no longer be able 
to enter new documents, OCR pages, or search for documents.  To remove this limitation, you 
must purchase a license.  A license is specific to what version and the specific machine the 
software will be installed on.  Please read the rest of the Introduction content section of this help 
file to learn how registration works. Please visit www.docs2manage.com for pricing options. 
 
Docs2Manage is copyright (C) 2001-2020, by COMvantage, Inc. All rights reserved. 
Anything not explicitly mentioned is prohibited. 
 
This software is provided "as is". In no event shall the author(s) or the company COMvantage, 
Inc., or other affiliated companies be liable for any consequential, special, incidental or indirect 
damages of any kind arising out of the delivery, performance, or use of this software. This 
software has been written with precision and testing, but is not warranted to be error free. 
 
You may not attempt to reverse compile, modify, translate, or disassemble the software in whole 
or in part. 
 
You may freely distribute the unregistered version of Docs2Manage provided that all the files are 
included and are unmodified and that no files have been added to the package. Please distribute 
it by copying the original set-up files. You may not ask any money for the distribution. 
 
If you want to distribute Docs2Manage on a CD-ROM or other compilation, please 
contact tglunz@docs2manage.com before doing so for approval. 
 
Available Editions of Docs2Manage 
Older versions of Docs2Manage (formerly Document Storage System) used to have two options 
in terms of editions or versions; these were the Standard and Enterprise Edition.  The Standard 
Edition had many restrictions that made it somewhat incompatible or at least made it inconvenient 
to upgrade to the Enterprise Edition, which was the unrestricted version of Docs2Manage.  
Beginning with Docs2Manage version 2.1.x these restrictions have been lifted and two other 
editions are now available.  The Standard Edition has been renamed to the Home Office Edition.  
All editions now support any database including enterprise databases, any storage medium for 
documents, any image format including B&W Tiff, use of the Repository, and Annotations- all of 
which were not allowed in the Standard (Home Office) Edition before. 
 
These editions will be described in more detail on the Docs2Manage Website along with a 
descriptive feature matrix should explain the differences between editions.  In brief, the editions 
are as follows: 
 
Personal Edition- Intended for personal use.  The Personal Edition only allows 5,000 documents 
(page records).  You can network this edition and use a client/server database, but support for 
this from Docs2Manage or COMvantage shall be optional.  The Personal Edition will only allow a 
single database connection and two (2) security groups or departments.  No viewer version will 
be available for this edition. 
 
Home Office (formerly Standard Edition)- Intended for home office use.  The Home Office 

http://www.docs2manage.com/cgi-bin/d2mweb.dll/PurchaseOrder
http://www.docs2manage.com/cgi-bin/d2mweb.dll/PurchaseOrder
mailto:tglunz@docs2manage.com
mailto:tglunz@docs2manage.com
http://www.docs2manage.com/
http://www.docs2manage.com/
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Edition allows 10,000 documents (page records).  You can network this edition and use a 
client/server database, but support for this from Docs2Manage or COMvantage shall be optional.  
The Home Office Edition will only allow a single database connection and four (4) security 
groups or departments.  No viewer version will be available for this edition. 
 
Small Business- Intended to be networked for a small business.  The Small Business Edition 
allows 50,000 documents (page records).  You can network this edition and use a client/server 
database and support is included when you purchase 5 or more licenses.  The Small Business 
Edition will only allow a single database connection and up to six (6) security groups or 
departments.  A viewer version and license packs are available to fit your companies' specific 
needs and budget. 
 
Enterprise- Intended for medium to large organizations or any organization with high volumes of 
documents.  There are no restrictions on the number of documents (page records) you can enter 
into the system.  You can network this edition and use a client/server database and support is 
included when you purchase 5 or more licenses.  The Enterprise Edition allows an unlimited 
number database connections and unlimited security groups or departments.  A viewer version 
and license packs are available to fit your companies' specific needs and budget. 
 
Docs2Manage OCR Plug-in 
Docs2Manage (D2M) OCR plug-in (optional purchase before version 4.x and now included 
for free beginning in version 4.x) - This feature was designed to improve document 
classification.  The OCR engine can extract the text from an image page and populating a 
database table with all the keywords which links directly to the page and document.  This means 
that if you do a search for a word or a group of words, and document that contains the word(s) 
you requested will be retrieved.  Pages will be highlighted in green when they contain the 
keyword(s) you searched for. 
 
The OCR process can also auto-rotate a page until the proper orientation is found so that the 
page can be both read on your screen and by the OCR engine. 
 
Extract Keywords from MS Word Documents (.doc .docx .rtf .txt .xls .xlsx .eml .msg .htm 
.html .wpd .wri .xml .pdf) 
D2M can also extract keywords from MS Word Documents and many other document formats 
when they are stored as a file (not as an OLE Windows Document).  These keywords will be 
stored the same way an OCRed image page is stored, even if the MS Word Document is several 
pages.  To use this feature, you must have the OCR Plug-in enabled. 
 
To configure and learn more about the OCR engine, please read the OCR Options section. 
 
The Trial Version 
Before Docs2Manage (D2M) is registered, any version may be tested.  Please select a version 
mode under the Registration menu in the Configuration program and refer to the Docs2Manage 
Website for details of each available version of Docs2Manage along with pricing information.  The 
OCR plug-in is fully functional in the trial and is included with the registered version starting in 
version 4.x. 
 
The trial is a fully functional program but does have limitations.  The trial version is limited to the 
first two database connections, although this restriction is lifted depending on the edition you 
purchase.   The number of security groups or departments is dependent on which edition you 
select in the Configure Docs2Manage program during the trial period or by registering the full 
version.  Please read what each edition of Docs2Manage will allow in the Available Editions of 

http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
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Docs2Manage section of this help file.  Also, after 5,000 documents (page records) have been 
entered or 60 days have elapsed (whichever comes first), you will not be able to add any more 
records and the search functionality will become disabled.  Once you purchase and register D2M, 
the restrictions will be lifted, and the Reminder screens will disappear.  Please read Configuration 
Overview & Registration on how to register your copy of D2M. 
 
NOTE: If you have an expired trial version of Document Storage System (DSS) or Docs2Manage 
2.0.4 or lower, you can install Docs2Manage version 2.1.0 or higher and the 60 day trial period 
will be reset so the newer version Docs2Manage or Docs2Web can be re-evaluated.       
 
Multi-user Support 
Before purchasing additional clients, the trial may be installed on multiple machines to test the 
multi-user functionality. 
 
For Docs2Manage (D2M) to be used in multi-user mode, each copy of D2M must be configured 
to use the same server and database.  It is recommended that each user have its own database 
login or user name.  Each database login should have a matching user name in D2M and should 
be added to the D2M Users area.  This will enable customized security for different users that 
access that database. 
 
For MS Access database must use a work group information file, which must be located on a 
shared directory on a network.  Each user must have full control to the share except the delete 
files right.  Every copy of D2M must be configured to use that Access database and work group 
information file.  Please see MS Access help about using Access in a work group.   
 
NOTE: If possible, please use an enterprise database.  Microsoft offers SQL Express, which is a 
great alternative to using a file-based database and is free on Microsoft's website. 
 
For an enterprise or client/server database, the appropriate database client software must be 
installed to allow a connection to the database server.  Please read your database's 
documentation on setting up a client and the ADO provider for that client.  Once this is done, use 
the D2M Configuration program to connect D2M to the database server and database. 
 
In any version, click the Test Connection button in the Configuration program to test the 
connection.  Even if the connection was successful, the database user must still have the proper 
rights to access the D2M database and tables.    
 
Database Support, Scripts, and Modifying Docs2Manage Tables 
VERY IMPORTANT: Document Storage System (DSS) versions 1.x - 4.x and D2M versions 
1.x through 2.x users please read Upgrading prior versions of DSS database to 
Docs2Manage.  This is necessary to upgrade in order to use the Annotations feature, OCR 
or Keywords feature, and the new security features and document explorer view.  If you 
open Docs2Manage (D2M) before the database is upgraded, D2M will prompt you 
regarding which tables are missing. 
 
The included MS Access database - MS Access 97 or higher as a stand-alone (multi-user is 
possible, but not recommended).  You must own a copy of MS Access to customize or to add 
new fields to D2M tables. 
 
Enterprise databases-  
The following databases test status and any additional notes stating possible issues with 
compatibility are listed below: 
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MS SQL Server 7 - 2017 / MSDE / SQL Express (Fully tested): Fully compatible, but SQL 2017 
Linux version not tested.  SQL Server is most tested, so it is most recommended for use. 
MySQL (tested with ODBC Driver 3.51.03 and higher): Fully compatible with ini file 
configuration change on MySQL Server.  Please read the notes in the MySQL DB Script file for 
further instructions. This database is free from MySQL.com 
Oracle9i or higher (Only version 9.2 was tested): Fully compatible.  Version 8i is no longer 
supported since it does not support ANSI joins, which D2M uses.  
IBM DB2 (Tested with FixPack 7 Applied): Fully compatible with ini file configuration change on 
each client.  Please read the notes in the DB2.txt SQL script file for further instructions 
Sybase Adaptive Server (12.0 fully tested): Fully compatible by using Sybase ADO driver 
available on the Sybase ASE 12.0 PC Client CD.  Please install the latest EBF to be sure the 
ADO driver is up to date or you may have some problems.  Do not use the ODBC data provider.  
Version 11.9.2 is no longer supported since it does not support ANSI joins, which D2M uses. 
Interbase 6.0 or FirebirdSQL (tested with Gemini ODBC Driver): Fully compatible.  Please 
visit InterBase Home Page for ODBC driver details.  This database is also free but does not have 
as much support and free tools available as MySQL. 
MS SQL Server 6.5 (Not tested): The provided MS SQL script must be modified so that varchar 
fields don't exceed 255 characters. 
ODBC Providers:  ODBC seems to work for other databases where a native ADO driver is not 
available.  Please test this before purchase. 
 
The Provided Database Scripts: If you plan to use MS SQL 7 - 2017, Sybase, Oracle9i+, IBM 
DB2, MySQL, or Interbase, the database scripts are provided in the Docs2Manage -> Database 
Scripts folder.  You can run the appropriate script in your database provided SQL Editor.  Please 
be sure to install the tables into the desired database and not into the MASTER database where 
the system tables reside; we typically create a new database named D2M.  Please consult your 
database administrator or database's documentation regarding this function.  For other SQL 
based databases not listed, build the required SQL using one of the existing scripts that most 
closely matches your database server's flavor of SQL.  Be sure that the table names and field 
names are unchanged or D2M will not work properly.  The data types and length may be modified 
but should generally match those in the sample scripts.    
 
Cloud Storage and Database Support 
Beginning in Docs2Manage Version 3.x, direct Dropbox support has been added, but you must 
install the Dropbox application to use in Docs2Manage. Dropbox runs as an application and 
automatically synchronizes a local folder with the files stored in the Dropbox cloud. The challenge 
with Dropbox is that it is stored in a different location on every computer it is installed on.  
Docs2Manage "figures out" were Dropbox is installed; so the only thing needed to use Dropbox is 
to configure Docs2Manage to use "Dropbox" as a storage method and specifying a sub-folder for 
only Docs2Manage documents. 
 
In terms of a cloud database, Microsoft created Windows Azure SQL cloud services. Windows 
Azure has an option to create a SQL Azure database. This database is available to 
Docs2Manage through the Internet. The SQL Azure database is just Microsoft SQL Server 
configurable through your browser rather than a local installation on a server on your network. 
Docs2Manage needs to be configured as if were connecting to a normal SQL Server instance, 
except the server is a domain name rather than a server name. 
 
With both cloud services being used by Docs2Manage; the user experience is no different than a 
non-cloud installation. In fact in many cases Docs2Manage actually works faster than the 
traditional set-up since documents are copied to the local machine rather than on a file share on 
the network. 

https://www.mysql.com/
https://www.mysql.com/
https://www.embarcadero.com/products/interbase
https://www.embarcadero.com/products/interbase
https://azure.microsoft.com/en-us/
https://azure.microsoft.com/en-us/
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Amazon Web Services (AWS) also offer SQL Server and Oracle cloud databases along with 
cloud file storage, although we have not tested this route, I suspect it should work good as well. 
 
However, we created guide "Guide to Setting up Docs2Manage using Cloud Services" separate 
from this to aid in using SQL Azure and Dropbox. 
 
Upgrading Prior Versions to Docs2Manage 4.x 
If you are currently using Docs2Manage version 1.19 or lower (version 2.x and higher the 
database is unchanged), you will need to upgrade your database to use the new features 
available in Docs2Manage. 
 
Jet (MS Access) Provider 
Before installing the latest version of Docs2Manage (D2M), you should backup your database 
(.mdb file) to protect it from being overwritten or corrupted during the install or upgrade 
procedure.   
 
To upgrade: 
1. Install D2M 
2. Open the D2M main program - you will be prompted to upgrade the database. 
3. Answer Yes to the upgrade the database. 
4. After the new tables and updates are installed successfully, you will be prompted of potential 
other updates you may need to apply. 
 
In the case of any failure, please note the error message and contact technical support. 
 
All other database providers 
After installing D2M, browse through the Docs2Manage -> Database Scripts folder under the start 
menu; open the database script that matches or best matches your database server's type.  
Inside the text file will be SQL statements to upgrade from a prior version.  This should be done 
by a database administrator with a clear understanding where the D2M tables are to be installed.  
This is the only section you need to execute against your database server and database.  This 
section will be marked in SQL comments as follows: 
-- New Table added for version 3.x DSS (or if you don't have a DOCANNOT table) 
... Specific SQL Code to create DOCANNOT table... 
-- END Of New Table added for version 3.x DSS  
 
-- New Tables added for version 3.04 DSS (or if you don't have a DOCWORDS table) 
... Specific SQL Code to create DOCWORDS table... 
-- END Of New Table added for version 3.04 DSS  
 
-- New Table added for version 4.x DSS (or if you don't have a DOCUSER and other security 
tables) 
... Specific SQL Code to create DOCUSER, DOCGROUP, DOCRIGHTS, DOCROLE, etc tables... 
-- END Of New Table added for version 4.x DSS 
 
/* "UPGRADING TO D2M 1.0" */   (or if you don't have a DOCTREE or DOCUSERLOG tables)  
... Specific SQL Code to create DOCTREE, DOCUSERLOG , and other updates... 
to the end of the script 
 
/* "UPGRADING TO D2M 2.0" */   (or if you don't have a DOCTEMPLATE table)  
... Specific SQL Code to create the DOCTEMPLATE table and other necessary updates... 

http://www.docs2manage.com/downloads/D2MCloudSetup.pdf
http://www.docs2manage.com/downloads/D2MCloudSetup.pdf
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to the end of the script 
 
Please be sure you execute this code in the same database where the other D2M database 
tables are located.  This database will contain the tables named DOCMAIN, DOCPIC, 
DOCCODE, etc.  Be sure to execute this code with the same rights or user as when the D2M 
tables were installed for the first time.  Grant your different database users with the proper rights 
to use this table.  If this is done successfully, you will not be prompted to upgrade your database 
when you open D2M, but to update the security information.  If you plan to be the D2M System 
Security Administrator or are the only user, answer Yes several times to update the security data 
in the new tables.  The database cannot be accessed with the new version until this operation is 
finished. In the case of any failure, please note the error message and contact technical support. 
 
Document and File Storage Support 
Document Storage System (DSS) and earlier versions of Docs2Manage always had the ability to 
store documents embedded into the database.  Beginning in Docs2Manage 2.0 has added the 
ability to store the documents added into a file system into a file directory, Windows file share, or 
on an FTP server.   
 
How files are stored is transparent to the end user.  However, the benefits of storing the 
document separate from the database are numerous.  These benefits include: 
 
Better use of database space 
When documents are stored in the database, more than 90% of the space used in that database 
are the actual documents.  This can be limiting depending on what database you use.  For 
example, Microsoft SQL Express 2005 is limited to 4 GB of storage per database.  This means 
when scanned documents are stored embedded in the database that a single database may have 
the ability to store approximately 50,000 to 150,000 scanned pages depending on the average 
size of a scanned page.  However, with documents stored outside the database in a file structure, 
the database can store approximately 1,000,000 scanned pages if the documents are OCRed 
and approximately 5,000,000 to 10,000,000 scanned pages in a system not using the OCR 
feature.  This means that a free products like MS SQL Express or Oracle Express become a very 
feasible solution even if the database will store a high volume of documents. 
 
Ability to store large files and performance 
SQL based databases were never designed to store very large files (10Mb+).  In the prior 
version, documents of this size could be stored in the database, but adding large files, viewing, or 
any other operation dealing with large files in the system usually came with long delays as the 
database fetched the data to rebuild the contents of a document.  In contrast to this, file 
directories, file shares, and FTP servers were designed to store and retrieve documents and files 
quickly. 
 
Greater database compatibility 
Docs2Manage always offered support to many different databases like MS SQL Server, Sybase, 
Oracle, and MySQL to name a few.  Support of these databases usually hinged on whether 
Docs2Manage could make error free calls using the ADO or ODBC driver the manufacturer 
provides.  MS SQL Server and Oracle always had the fastest and most dependable ADO drivers 
available.  MySQL and Sybase tended to have problem both in performance and compatibility 
when it came to large data (BLOB) support needed to store files in a database; sometimes this 
would work in one version and then have issues in the next version.  Storing the documents in a 
file structure instead of the database yields better database compatibility and performance. 
 
More file compression options 
Docs2Manage 2.0 has also added the ability to change the level of compression when files are 
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stored in the system.  This does not affect scanned images which are stored in their native 
compressed format.  The speed of the compression (and decompression) has also improved.  
This version also allows the ability to completely turn off compression or to turn off compression 
when files are greater than a specified size.  For example, if you wanted to use Docs2Manage to 
manage your MP3 library, you could set Docs2Manage to not compress files greater than 1Mb.  
Since MP3s, other audio, and video formats are already highly compress there is no gain in 
compressing them any further. 
 
All this functionality is set at the security group level.  Please refer to the Groups, Document 
Storage, and Users section for details how to configure your system.  
 
WARNING: Although it is possible to use a different storage type and location for each security 
group, it is highly recommended to keep the storage type and location the same for all groups.  If 
you elect to have different storage types or locations in a single database, you will not be able to 
view other repositories that have a different storage type or location even though you may have 
right to those repositories in other groups.  Also, avoid switching an existing repository from one 
group to another if they have different storage types or locations.  These conditions and warnings 
do not apply if you use the same storage type and location for all groups. 
 
High-speed scanning / Benchmarks 
High-speed scanning theory 
High-speed scanners are optimized for Black & White (B&W) scanning.  Docs2Manage (D2M) 
supports B&W Tiff as an image mode in any edition and is the best choice for general document 
management.  Most other graphic modes are considerably slower and will degrade the 
performance of high-speed document scanners, mainly because other image modes in D2M 
create larger image sizes.   
 
Benchmarks 
To test D2M, several different Fujitsu high-speed scanners were used.  The fastest of the models 
tested was a Fujitsu M3097DG SCSI duplex scanner capable of 44 pages per minute (ppm) and 
80 images per minute (ipm) in duplex mode.  On the workstation Docs2Manage was configured 
to connect to an MS SQL Server database.  Scanning was performed using the automatic 
document feeder (ADF) using 8 1/2 x 11" document in landscape mode at 200 dpi. 
 
Scan results 
In Simplex Mode, 43 ppm were scanned into a single D2M Document (into a repository). 
In Duplex Mode, 38 ppm (76 images per minute) were scanned into a single D2M Document (into 
a repository). 
 
The role of the repository with respect to high-speed scanning 
The ability to scan many unrelated documents into a single record and later move them to new 
documents helps separate the functions of D2M users.  One user may scan documents non-stop 
while at another time or another user may move pages from the repository to categorized new 
document(s). 
 
Getting Started (General steps to use Docs2Manage) 
Before you use the main Docs2Manage (D2M) program, you may want to use the Configuration 
program to edit the settings or database connections this program will use, but by default D2M 
will connect to the provided MS Access blank or sample databases. 
 
When you first load the main program, you may consider setting up the security layer D2M will 
implement using the options under the Security menu.  This will display or hide many of the 
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controls and features in D2M for the various types of users you may have per your security 
needs.  Please read about this in the Security and D2M section of the help file. 
 
Before you start adding documents to the system, you want to consider how and where you want 
to store the documents.  By default, Docs2Manage will store your documents in a folder named 
"Docs" in the Docs2Manage program folder.  If you are using any other database besides the 
provided MS Access database, Docs2Manage will default to use the database to store 
documents and files.  However, it would be preferred if you change this setting to use a file 
structure for better performance.  If you plan to use a file structure on a network, a file share is the 
preferred file structure or you can use a file directory if you want the documents to be stored 
locally or you want to use a directory on a file server that is already mapped and authenticated on 
your local machine.  This setting is discussed in detail in the Groups, Document Storage, and 
Users section of this help file. 
 
Also, you may want to customize the fields used to classify the document before you begin 
entering documents.  You may display up to six classifying fields which you customize in the Field 
Manager.  These are also all the fields that can be searched by using the Search button located 
on the main toolbar.  If you need more than the six classifying fields, please read the Adding and 
Using Additional User Fields section.  Remember most of the classifying will be done using the 
folder structure in the Document Explorer view, so try to avoid adding to many classifying fields.  
This will only create more work for the user who is entering the documents. 
 
Create a Folder Structure in Document Explorer 
When you first enter D2M, you will see the Document Explorer View where you will create a 
folder structure where documents may be placed and stored.  You must create at least one 
folder. 
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To add a Folder: 
1. Click the New Folder button on the main tool bar. 
2. Customize the Folder name in the Document Explorer. 
3. Add additional folders by repeating steps 1-2. 
 
To add a Sub-Folder: 
1. Select the Folder to create a sub-folder under. 
2. Click the down arrow button next to the New Folder button on the main tool bar. 
3. Click New Sub-Folder from the drop-down list. 
4. Customize the Sub-Folder name in the Document Explorer. 
5. Add additional sub-folders by repeating steps 1-2. 
 
Alternatively, you may right-click the Document Explorer area instead of using the main tool bar to 
create, rename, and delete folders. 
 

 
 
Show Unclassified Documents Check-box 
If you are using Document Explorer, and you see the "Show Unclassified Documents" check-box 
at the bottom of the Document Explorer Tree, it means you have documents that have not been 
assigned to any folder in the Document Explorer Tree.  To resolve this, simply check the Show 
Unclassified Documents check-box and a list of documents will show on the right side.  Simply 
select one or more documents and drag them to the desired Document Explorer Tree folder on 
the left.  This is the only way to classify documents if you create a document tree in a system that 
already has documents stored (that could not be assigned to any Document Explorer Tree folder 
because it did not yet exist). 
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Enter Document Information 
Once you have defined your folder structure, you are ready to add your first document.  First 
select the folder you want the document to appear in.  Next, either click "Scan" button or "Import" 
button to import an existing file on the main toolbar.  This will open a dialog where you can enter 
the information about the document you are about to add.   
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Add Pages to a Document 
After you have entered information about a document, click the "Scan Pages" or "Add Pages" 
button on the bottom of the form. 
 

 
 
When scanning: 
1. The scanning interface will display. 
2.  Load the scanner with your document and press the scan button.   
3. The scanner interface will remain open to allow you to add many sets of pages.  Press cancel 
or close to close the scanning interface. 
4. The document should appear in the document grid unless you categorized the document in a 
different folder than you had selected. 
 
NOTE: D2M assumes you do not need to see the document you just scanned.  If you do want to 
see what you just scanned, double-click the document record in the grid or press [F12] to display 
the Pages Form.  You can also do this if you need to add more pages to this document later. 
 
When importing:  
1. Click Import Document(s) from File button toward the bottom of the page. 
2. Select desired file(s) and click Open button.  The new pages will appear in the thumbnail or 
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grid view of the form. 
3. To save time, you can also drag-and-drop files into D2M. 
4. Use the Document Image Data Navigator at the top of the form to navigate page-to-page, 
change the order of pages, or delete pages. 
5. Click OK button when you are finished. 
 
While in D2M, additional help is available by setting focus on the control or field you need help 
with and pressing the <F1> key. 
 
Definitions 
ADO or OLE DB:  Microsoft latest universal standard for database connectivity.  This standard 
allows D2M to use many different databases without changing the program itself. 
 
Annotations:  Mark-up to an image. 
 
Automatic Document Feeder (ADF):  Some scanners can use a document feeder.  Even if your 
scanner does not have a document feeder, you may be able to purchase one for it.  In the D2M 
configuration program, there is a setting to let D2M know if you have a document feeder so that 
you can scan multiple documents at one time through the feeder. 
 
Cropping:  This is the process of removing unneeded border. 
 
Database:  The place where Docs2Manage stores the classifying information about your 
documents.  Client/Server databases like MS SQL Server (SQL Express), Oracle (Oracle 
Express), MySQL, and Sybase are optimized to organize and find your data or documents much 
quicker than data stored in a flat file since all processing of the data is done on the server and not 
on the local machine. 
 
Deskew:  This is the process of determining the angle of skew of a scanned page and correcting 
the condition by rotating that page by that angle to make it appear straight.  This process works 
best when there is some sort of defined lines or borders to the document image. 
 
Despeckle:  This is the process of removing speckle or noise from your Black & White document 
images.  This not only makes the image cleaner, but also reduces storage space. 
 
Document Information record:  This is the information about the document stored in the 
DOCMAIN table. 
 
Document Page record:  These are the pages of a record stored in the DOCPIC table.  For 
example, the US-1040 is one document that contains 2 pages. 
 
D2M:  Acronym for Docs2Manage 
 
DSS:  Acronym for Document Storage System, the former name for Docs2Manage 
 
Document Templates: Beginning with Docs2Manage v2.0 document template support has been 
added as a convenience.  This gives the ability to create documents from blank forms you may 
have created in the past.  When you create a document from a template, you can edit the 
document and save it to the system when you are finished, but the document template remains 
unchanged so it can be used again in the future. 
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Duplex Scanner:  A scanner with an ADF capable of scanning both sides of paper. 
 
File Directory:  Typically refers to a direct on a physical or mapped drive on your computer.  
Docs2Manage does not need to authenticate the connection to the directory.  Since this type of 
file structure does not need to be authenticated or is already authenticated by the system special 
care should be given that a user does not go into the directory structure and change files outside 
the system; because of this, a file share which can require authentication is the preferred file 
storage method recommended for Docs2Manage.  However, Docs2Manage can use this 
structure for local installations and this allows Docs2Manage to use UNIX servers for file storage 
through Samba. 
 
File Share:  Typically refers to a directory in Windows that has been marked to share its files.  
The share can be set up so only certain users can access the share.  This is the most preferred 
method for Docs2Manage to store you documents because Docs2Manage can authenticate into 
a file share that the desktop user does not know and cannot authenticate into. A file share usually 
is identified beginning with a "\\" (without quotes). 
 
FTP (File Transfer Protocol) Server:  A server and protocol commonly used for accessing files 
on the Internet through simple password authentication. 
 
File (Document):  When you add a file to D2M and you specify to store it as a file, D2M is not 
aware of the format.  This is good if a computer needs to add an MS Word Document or 
equivalent to D2M but does not have that software installed or installed properly.  D2M simply 
compresses the file and stores it.  A computer that has the proper software to edit the file should 
be able to open the document from within D2M. 
 
Image (Document):  If you scan or add an image from an acceptable graphic file, the data is 
stored in a compressed image format to save disk space.  Most scanners save images as 
Windows bitmaps. 
 
Internationalization:  The ability for an application to change languages and character sets to 
match the local language.  Docs2Manage can change languages to any one of ten different 
languages including English (default), Spanish, German, Chinese, Arabic, and many more.  If 
your language is not supported, there is even a way to add your own language or modify one of 
the existing languages. 
 
OCR (Optical Character Recognition):  This is the process of extracting letters or words from 
your document images.  D2M uses these characters to form the keywords that are tied to your 
documents.  These can be searched much like a keyword on a web search engine. 
 
Repository:  This is the area of D2M acts as an in-box of unrelated / unclassified documents 
where they can be passed on to other repositories or users and classified later.  The advantage is 
that it can hold hundreds if not thousands of documents without cluttering your physical 
workspace. 
 
Simplex Scanner:  A scanner with an ADF but only scans one side. 
 
Thumbnails:  A miniature representation of a page image. 
 
Windows Documents (OLE Documents):  When you add a file to D2M, you may add it as a 
Windows Document or as a file.  If you store it as a Windows document, D2M is aware of the 
format of the document via Microsoft OLE.  Because of this, the document image preview may 



 15  

show an icon or preview of the real document.  In order to add a document as a Windows 
document, the proper editor must be installed on the client's computer. 
   
What's New in This Version 
Docs2Manage v4.0.0 - OCR Plug-in now included for free / Various Fixes / Windows 10 
Compatibility 
The Tesseract OCR Engine is now supported at no cost.  This engine by default is set-up for 
English Optical Character Recognition (OCR), but many other languages are supported by 
downloading the appropriate language file(s).  There is also support for optimizing the OCR 
engine for speed versus quality.  You can now create your own custom splash screen to 
distribute your Docs2Manage back-ups/filtered archives onto a royalty-free distribution CD/DVD. 
Please read Backing-up the Database / Build a CD-Rom Archive Dialog and Creating and Using 
Your Own Splash Screen to understand how to do this.  This version also adds the ability to burn 
the CD/DVD ROMs from inside Docs2Manage as older versions you had to do that with a 
separate third-party program.  This version has been tested on Windows 10 and is fully 
compatible except the use of the Docs2Manage Printer (Capture), which is being deprecated. 
 
Docs2Manage v3.1.0 - Updated PDF Support / Security Fixes / Windows 8 Compatibility 
This version has been tested on Windows 8 and is fully compatible except the use of the 
Docs2Manage Printer (Capture).  The integral PDF viewer has also been updated to support 
newer standards. In addition to these fixes, Docs2Web has been updated to prevent the 
possibility of SQL injection venerability.  If you use Docs2Web on a public website, it is highly 
recommended you upgrade to this newer version as this version eliminates that issue.  The core 
program executables are no longer compress as with today large storage is no longer necessary 
and this compression causes some Malware programs to give a false positive.  A bug was fixed 
that caused the software to be register for one user on a machine, but another user to be 
unregistered on the same machine.  Usually this was the case if one user was an administrator 
and the other user was not.   
IMPORTANT NOTE: Upgrading to this version may cause some users to need to be re-
registered but going forward the registration should work for all users on a single computer.  If 
you believe you should be able to upgrade to this version because you are within the 1-year 
upgrade window, but receive an error message, please contact Docs2Manage via email to 
resolve this issue.  You may need to have your license reset. 
 
Docs2Manage v3.0.0 - Cloud Support 
Cloud support has been added making use of Microsoft's "Windows Azure" SQL cloud services 
(azure.microsoft.com) for the database functionality for Docs2Manage, which is equivalent to 
using SQL Server.  And for disk storage, special support has been added for Dropbox 
(www.dropbox.com).  In brief, Dropbox is an application that accesses cloud server storage and 
automatically sync files and data in a local directory to maintain high speed data access.  One or 
both services can be used efficiently and is an inexpensive way to not have the need for any local 
servers for Docs2Manage.  This also gives the best method to make Docs2Manage completely 
portable, since both services are available via the Internet. 
 
Better Vista/Windows 7 Compatibility 
Docs2Manage has been changed to save temporary and application data like the included MS 
Access database and Documents to the AppData/Local directory rather than the Docs2Manage 
program folder.  This is the preferred method for newer version of Windows as claimed by 
Microsoft.  This should eliminate security warning messages if you run using User Access Control 
(UAC), which is "on" by default for newer Windows operating systems.  This also has the benefit 
of segregating the application data separate from the install directory, decreasing the risk a re-
install can overwrite data (for users using the included MS Access database and default storage 
folder).  If you use a database other than MS Access and local document storage, this change 
does not affect you in anyway, other than the location of temporary data, which does not affect 

https://azure.microsoft.com/
https://azure.microsoft.com/
https://www.dropbox.com/
https://www.dropbox.com/
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the functionality. 
 
IMPORTANT NOTE: If you installed prior version of Docs2Manage, the database and document 
folders will be left intact.  However temporary data will use the new folder.  Also, if you are using 
the local MS Access database and local disk storage, you must remember to make a back-up of 
this data (typically: C:\Users\{profile name}\AppData\Local\COMvantage\Docs2Manage).  Also, 
test that a new machine has your data before decommissioning an older computer, since backing 
up your Docs2Manage program directory will not contain your data as it did in the past. 
 
Docs2Manage v2.5.0 - Web Registration / License Transfer 
Web initiated registration and license transfers have been added to both Docs2Manage and 
Docs2Web.  Now when you purchase a license, you will be given a registration key which is 
transferable from machine to machine- although the number of transfers per year is limited.  
Registration now can also be initiated from the main Docs2Manage application where this was 
not possible in prior versions. 
IMPORTANT NOTE: This version uses a new license key system, so if you have a current valid 
license and install this version on top of a version before 2.5.x, then the application(s) will become 
a trial version.  You must send an email request for new registration keys to use this version or 
higher assuming your license is still current for the date of this release. 
Docs2Manage v2.2.0 - Ability to Add Pages to Existing Documents from Repository  
If you find it necessary to add pages to existing documents in bulk, you can scan or add 
document pages to the repository first, and then access those pages by right-clicking either the 
document record on the main document grid or by right-clicking the page thumbnails or grid on 
the document pages form, select "Select Pages from Repository", select the pages you desire to 
add to the existing document, and click the "Add pages to Document" button. 
Shared Repository Names 
Repository names are no longer stored in each computer's system registry, but in the database.  
If you use the repository in an older version of Docs2Manage, you will have to name the 
repositories again in Repository Set-up.   
Docs2Manage v2.1.4 - Renewable Trial Licenses 
If you have an expired trial version of Document Storage System (DSS) or Docs2Manage 2.1.3 or 
lower, you can install Docs2Manage version 2.1.4 or higher and the 60-day trial period will be 
reset so the newer version Docs2Manage or Docs2Web can be re-evaluated.  The trial edition 
now allows 5,000 documents (page records) along with a 60-day trial period. 
Various fixes 
Install program installs more reliably into Windows Vista (also tested on Windows Vista SP1).  
Problem that caused program to not load after trial license expired has been corrected.  A couple 
minor bugs in the search engine have been corrected. 
 
Docs2Manage v2.1.3 - Installer Improvements 
The installer now attempts to set the proper rights so other users on the system can access and 
use Docs2Manage settings.  Please install Docs2Manage as an administrator to take advantage 
of this.  
Improved Integral PDF Viewing 
The built-in PDF viewer has been updated. 
Back-up to CD-ROM Improved 
Bug corrected dealing with number of database connections that occurred in version 2.1.0 and 
2.1.1.  Also, made it possible to run D2M from portable or memory based (thumb) drives if files 
are on the base of the drive.  Since, these drives are not autorun drives, simply execute the 
Docs2Manage.exe to start Docs2Manage in CD (read-only) mode. 
 
Docs2Manage v2.1.1 - Enhanced OCR Support 
The OCR Engine has been updated in both performance and accuracy.  The OCR engine also 
now recognizes European accented characters. 



 17  

 
Docs2Manage v2.1.0 
New Editions Added 
Beginning in this version the image format, database, and storage restrictions were removed 
making the path easier to upgrade to higher editions in the future.  Also, two new versions were 
added to fill in the gaps to fit the needs of the home user and different size businesses.  Please 
read what each edition of Docs2Manage will allow in the Available Editions of 
Docs2Manage section of this help file or find more details about this on the Docs2Manage 
Website. 
 
Vista Support 
The help system in versions before this one will not function on Windows Vista.  The help system 
was converted to use HTML help instead of Winhelp which is not supported on Vista.  There does 
not appear to be any other issues of incompatibility on Vista. 
 
Renewable Trial Licenses 
If you have an expired trial version of Document Storage System (DSS) or Docs2Manage 2.0.4 or 
lower, you can install Docs2Manage version 2.1.0 or higher and the 60-day trial period will be 
reset so the newer version Docs2Manage or Docs2Web can be re-evaluated.  The trial edition 
now allows 5,000 documents (page records) along with a 60-day trial period. 
 
Less Restrictive Text Extraction 
European characters can now be extracted from text-based documents (Word, Excel, text-based 
PDFs, etc.).  In the next few months we hope to make the OCR engine have this ability as well. 
 
Docs2Manage v2.x 
Expanded Document Storage Support 
Docs2Manage and Document Storage System (DSS) always supported document storage 
embedded in the database.  This means that a database back-up backs up everything in the 
system, classifying data and documents.  Besides this support, this version also allows document 
storage on a local storage device (hard drive, flash drive, or thumb drive), network share, or on an 
FTP server.  This provides faster access to documents while saving space in the database.  For 
example, MS SQL Express (free version) has a 4 GB database size limitation.  Having the ability 
to store the documents separate from the database gives the possibility of 1,000,000 to 
5,000,000 document pages instead of 100,000 pages if the documents are stored embedded in 
the database.  All this functionality is set at the security group level.  Please refer to the Groups, 
Document Storage, and Users section for details how to configure your system.  
 
Internationalization and multi-language support 
This version introduces the ability for an application to change language and character sets to 
match the given language.  Docs2Manage can change languages to any one of ten different 
languages including English (default), Spanish, German, Chinese, Arabic, and many more.  If 
your language is not supported, there is even a way to add your own language or modify one of 
the existing languages.  To change the language in Docs2Manage, please see the Language, 
Font, and Application Theme Options section in this help file.  Docs2Manage stores these 
languages in an external table making it possible to make specific changes to words in 
Docs2Manage.  Docs2Manage even has a dictionary utility that translate other languages not 
included in Docs2Manage making it possible to add a language to Docs2Manage.  For more 
details on this functionality please read the Internationalization and Language Support section of 
this help file. 
 
Document Templates 
Document template support has been added as a convenience.  This gives the ability to create 

http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
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documents from blank forms you may have created in the past.  When you create a document 
from a template, you can edit the document and save it to the system when you are finished, but 
the document template remains unchanged so it can be used again in the future.  Please read 
the Document Template Support section for more help about this topic. 
 
Reporting about your documents 
Docs2Manage now includes a way to create ad-hoc reports about your documents.  This report is 
generated based on the search results in document grid.  This report can either be printed out or 
saved to a formatted text file. 
 
Docs2Manage v1.x 
New Name 
Docs2Manage (D2M) is the new name of program previously called Document Storage System 
(DSS) built on the same basic concepts as DSS. 
 
Document Explorer 
Work in this mode to easily view and modify the folder structure on the left side of the window.  
The highlighted folder's document results are displayed on the right side.  Double-click a 
document record will open the document to view the pages. 
 
Simplified interface 
The user interface is less complex and more intuitive even for the new user. 
 
Thumbnail Support - Search and view your document by using thumbnail representations of all 
your pages in a document.  The Documents Page form has a Thumbnail View of all the pages in 
a document.  Alter the thumbnail size by using the Page Pop-up Menu.  Select from three sizes:  
small, medium, and large.  Default is medium. 
 
Security Event Logging 
Ability to audit and track who and when your documents are accessed. Additional security 
features have been included to fulfill requirements in numerous industry security standards.  D2M 
can track and report virtually every activity in the program using event logging.  D2M has defined 
nearly 40 tasks, or "rights."  You can decide which rights to log under the Security menu.  Select 
from two reports that display the logging activity. 
 
Customizable Themes 
Customize the look of the D2M user interface (windows, buttons, etc.) by changing themes.  You 
may select from one of the predefined options or add your own by adding the D2MTheme.skn file 
to the Docs2Manage installation directory.  Using the custom setting gives the ability to match 
corporate colors and brand identity of your company or organization.  Look for details on 
the www.docs2manage.com website about creating or using a custom theme. 
 
Stored Files now have Preview 
When this option is "on", D2M will attempt to create a page preview for files that are stored in 
D2M.  This allows you to see documents like MS Word or Excel without the need to open them to 
view. 
 
Document Storage System (DSS) Feature History 
Security and Departments (Version 4.x) 
Starting in DSS Version 4.x, DSS supports integral security.  The concept of security starts with 
security groups.  Each security group has its own "virtual" database for each department in an 
organization.  Each group can customize the DSS categorizing fields to fit each group or 

http://www.docs2manage.com/
http://www.docs2manage.com/
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department's needs.  Next, DSS allows or denies certain rights for different users.  By storing all 
the possible users in the database, these users are given the same user names that the database 
uses.  This means that in order to access documents, the user must have the proper rights to 
both the database and in DSS.  Then the DSS program was divided into nearly 40 tasks or rights, 
which a user may or may not have in a group.  A collection of rights makes up a role.  When a 
user joins a group, that user is assigned a role.  A user can have customized rights that deviate 
from the role by adding or removing rights to the actual user.  A user can be given different roles 
and rights for each group they are joined to.  If a user is not part of a group, then simply they 
cannot access that group.  For more information and task necessary to implement security in 
DSS, read the Rights and Roles, Group and Users, and Joining Users to Group / Special 
Rights sections. 
 
Document Locking  
Along with Integral DSS Security came the possibility for users to lock documents.  A lock can be 
placed or removed on a document by clicking the "Lock Toggle" button on the main toolbar in 
DSS.  To limit other users from editing the document, there are two different types of locks Public 
or Private.  To read more about the differences in these locks and about document locking in 
general, please see the Document Locking section about this topic. 
 
Convenience Options 
For your convenience, the following features can be configured: 

•  Default Format when Storing Non-image Files instead of always being prompted what format 

to add a file. 
•  Show Icons in Page Grid with the ability to shut this feature off to conserve row space. 

•  Go to page feature to quickly jump to a specified page 
 
Previewing Documents Stored as Files 
When documents are stored as a file, DSS will display either a preview of the actual document or 
an icon in the image preview area.  To create the preview, DSS will load the document into a 
special viewer, which attempts load a preview image or icon based on the file that is trying to be 
previewed.  Please read more about this option in the Preview Documents Stored as Files section 
about this topic. 
 
E-mail Capability (Version 3.06) 
DSS now has an E-mail button on the image toolbar.  This works much like the "Save" button, but 
the E-mail button assumes you want to E-mail your document.  It opens your default MAPI 
compatible E-mail client, creates a new E-mail message, and adds the document as a file 
attachment.  The only other information that needs to be entered is the message subject and the 
recipient's E-mail address.  Please read the Buttons to Add or Modify Documents and 
Images section about this topic. 
 
DSS New User Configuration Wizard (Industry Wizard) 
This dialog box appears when DSS is first installed and the main DSS program is run.  It serves 
to guide the new user to select which version of DSS is appropriate for them, whether to open a 
blank or sample database, and allows them to select an industry and further customize the entry 
and search fields to fit the needs of the user's organization.  Please read the DSS New User 
Configuration Wizard section about this topic. 
 
Extract Keywords from MS Word Documents (.doc, .rtf) 
DSS can now extract keywords from MS Word Documents when they are stored as a file (not as 
an OLE Windows Document).  These keywords will be stored the same way an OCRed image 
page is stored even if the MS Word Document is several pages.  To use this feature, the OCR 
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Plug-in and MS Word must be installed. 
 
Auto-narrowing Searches (Smart Searches) 
This feature makes searching more logical by repopulating the search drop-down edit fields or 
search tree with values that exist in the current results as if the search was executed.  As you 
select search values, queries determine the values that exist for the other fields you have not 
search against yet, so you are only left with choices that will yield results to the search you may 
next attempt.  Please read the Auto-narrowing your Searches  section about this topic. 
 
Auto-Cropping 
Auto-Cropping attempts to determine where the edge of a document is and eliminates the white 
space outside that region.  This can be done during and after the scanning process.  This feature 
only works against B&W Tiffs.  Please read the Image View Manipulation Menu section about this 
topic. 
 
International Font and Character Set Support 
This feature allows you to select a different character set, font, and size, which you may have 
installed on your system for other languages.  This will change the character set and font for 
every control inside DSS except the menus, which is controlled by Windows.  This feature does 
not translate the languages used, but you can customize your entry fields to change the actual 
language.  Please read the Font and Character Set Options section about this subject. 
 
On-the-fly Search Tree View 
Rather than using the search dialog, the tree diagram approach works much like Windows File 
Explorer.  For example, selecting the folder "Bank" may have three source nodes under it labeled 
"First Bank", "USA Bank", and "Skokie National Bank".  This feature is one of the views available 
by clicking the "View Toggle" button. 
 
Redesigned Field Manager Screen (formerly Field Codes) 
The grid in the Field Manager screen is now only used to display the multiple values when a 
column is defined as a drop-down edit control.  At all other times, the field manager is in the 
format of a form.  Also, only one field at a time can be modified by selecting which field you desire 
to edit using the column search drop-down field. Please read the Entering Information about Data 
Fields section about this subject.  
 
XP Menu Themes, Document Icons, and Enhanced Data Grids 
The menus have been redesigned to include representative icons and changed to support the 
Windows/Office XP theme.  All grids now support alternating colors between data rows, 
document type icons and descriptions have been added to the pages grid, and double-line 
column headers. 
 
Improved DSS Back-up 
The back-up process has been improved by writing the back-up data in smaller chunks.  This will 
prevent some of the out-of-memory errors that may have occurred when backing up a larger 
database.  A progress bar has also been added to track the status of the back-up process.  
Please read the Backing up the Database / Running DSS from a CD-ROM Dialog section about 
these changes. 
 
OCR Plug-in (Version 3.04) 
The optional OCR engine is capable of extracting the text out of an image page and populating a 
database table, which links directly to the page and document.  This means that if you do a 
search for a word, or a group of words, any document that contains the words you requested will 
be retrieved.  Pages that show as green in the page grid, will contain the word(s) you searched 
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for.  The OCR process can also auto-rotate a page till the proper orientation is found to better 
read the page both on your screen and by the OCR engine.  Please read DSS OCR Plug-in about 
this update. 
 
Powerful Keyword Searches 
The OCR feature now populates the new DOCWORDS table.  This means that every word in 
your document can be used to help find the desired document.  The search screen allows you to 
perform keyword searches very similar to web search engine.  If you don't opt for the OCR Plug-
in, you can still add your own searchable keywords to the Keywords form.  Please read 
the Keywords Form section about editing or viewing page keywords. 
 
More Dynamic Page Loading 
DSS used to always attempt to load all pages in a document at one time.  This could cause a 
great delay for documents or repositories that had a high number of pages.  DSS now only loads 
the current page data needed to display the current page in the preview area.   
 
Security 
DSS is now capable of being password protected.  When a database connection is configured to 
not store the database password as part of the connection, DSS will display a password prompt 
dialog when DSS is attempting to be opened.  Please read the Security and DSS for more 
information about this change.  More specific security control will be coming soon. 
 
Image Format Support 
In addition to Jpeg image format, 1-bit Black and White Tiff, 8-bit grayscale Tiff, and PNG image 
format are now supported.  These formats available in DSS give DSS no image quality loss 
support and better storage for documents ranging from B&W to full color.  B&W imaging allows 
DSS to use high-speed scanners more efficiently.  B&W Tiff can scan at much higher quality 
while having smaller image storage sizes.  Please read the Image Formats section for more 
information about this update. 
 
DSS Printer 
DSS now has a way to capture printed documents through a DSS printer.  This eliminates the 
need to print documents on paper and then scan them into DSS.  This DSS Printer can be 
installed while the DSS software is being installed or via the DSS Config program.  This printer 
can be shared on a network to allow many users to add documents to DSS at the same time.  
Please read the DSS Printer and Printer Capture Mode or Installing the DSS Printer sections for 
more information about this update. 
 
Repository Mode 
In prior versions of DSS, scanning pages of a document could not be moved to other documents.  
Because of this, you always had to have your documents organized so they could be scanned 
into the appropriate document information record.  The repository eliminates this problem by 
allowing you to scan large amounts of completely unrelated documents into a repository where 
they can be moved to new documents later.  This lends itself to high-speed document scanners, 
which can be loaded with many pages at one time to scan and then digitally organize them later.  
Please read the Repository Mode for more information about this new feature. 
 
Workflow View and Options 
While in the repository mode, clicking the view toggle will switch DSS into a tree view of all the 
existing repositories (directories).  Pages can be selected from one repository tree or page grid 
and dragged directly into another repository.  This allows DSS users to pass documents to 
different users' repositories, so that a user that may know more about them can categorize them.  
There is also a setting to refresh the tree view so as documents move; they will automatically 
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show in the new location.  Please read the Workflow & Repository Tree View for more information 
about this new feature. 
 
Annotations 
This new feature allows you to mark-up or add graphical features to an image.  This could be 
feature like a rubber stamp to a post-it note, shape, or line.  These annotations are stored on a 
separate layer than the image so they can be modified or removed in the future.  There is an 
option to print and image page with or without these annotations. Please read the Annotations 
Mode for more information about this new feature. 
  
Printing 
DSS used to rely on third party software of your choice to print documents stored in DSS, but now 
DSS now allows you to print one or all of the image-based pages tied to a document.  There are 
also some sizing options to tell the printer how these pages should be printed.  Please read 
the Printing Options for more information about this new feature. 
 
Greater scanner control 
DSS now include some features to aid in the use of high-speed scanner including duplex 
scanning options.  There is even an option to detect and eliminate blank pages, deskew, and 
despeckle while scanning in Tiff mode.  Images can also be rotated while they are being 
scanned.  Please read the Scanning Options for more information about these updates. 
  
Image Manipulation 
Document images of any type can be cropped or rotated.  Black & White Tiff images can also be 
despeckled, deskewed, and blank pages can be detected.  Please read the Image View 
Manipulation for more information about these updates. 
 
Field Manipulation 
DSS now has greater field control over the main DSS fields.  Besides the two date fields, the 
other fields can be either a field edit or combo box.  These fields can also be hidden when they 
are not needed.  As in the last version, all fields can be renamed to fit your purposes.  Please 
read the Entering Information about Data Fields for more information about these updates. 
 
Keyword Searches (of multiple words in any order) 
The Notes/Keywords field allows you to enter multiple words and sentences to the limit that your 
database will allow.  In the Search dialog the Notes/Keywords field allows you to search for 
records using keywords separated by spaces.  This works much like a web search engine 
search.  Words can be searched in any order.  The "Match all keywords" checkbox when checked 
means that all the words you search must be contained in the record you are trying to find, but in 
any order.  When this checkbox is unchecked then any records that contain any one of the words 
you are trying to find will be returned. 
 
Image readability 
DSS now uses anti-aliasing schemes to make B&W tiffs look like grayscale in the image preview 
areas. This will make a speckled image look more gray-toned. As a result, scanned tiff image 
documents look very readable even when they are scaled small on the screen. This does not 
affect how B&W Tiffs are saved or printed in DSS. 
 
Database performance 
Beginning in DSS version 3.04+, DSS now will attempt to load the current page rather than all the 
pages in one document.  This prevents very long waits that may have happened in the past when 
a single repository or document contained a great number of pages.  Please read Database 
Connection / Building the ADO Connection String about this update. 
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Internationalization and Language Support 
Docs2Manage now has internationalization support which allows the ability to change the 
language and character set used by Docs2Manage to one of ten other languages.  There is even 
the ability to add your own language if it is not already supported by Docs2Manage. 
 
This section will focus on how to make changes to the language you are using and how to add a 
new language to Docs2Manage that is not included currently.  To simply change the language 
Docs2Manage uses please visit the Language, Font, and Application Theme Options section in 
this help file for instruction.  If the language you desire is not listed, please select the "User 
Defined" option.  If you have selected a language other than English, the default, and find that a 
translation is incorrect or could be worded better, you may want to edit the translation. 
 
Docs2Manage Dictionary program 
Contains a distinct list all the possible words and phrases that Docs2Manage uses.  The 
dictionary is based on a file named "D2MLang.dic" in the program directory.  The main purpose of 
this program is to access Babel Fish or SYSTRANBox translation web services to perform mass 
translation on the more than 2,000 words and phrases Docs2Manage uses.  This program 
displays all the languages in columns with the first column being the default, English.  The 
"Translate Language" feature under the "Tools" menu gives you the ability to translate a new 
language, which will be described below.  For more help with the Docs2Manage Dictionary 
program, please view the Dictionary Help included in the "Docs2Manage" program group under 
the "Language Translations" folder.  
 
Docs2Manage Translation Tables program 
The Translation Table Program maps the translations to the strings and captions the program 
uses.  The tables for Docs2Manage are split up by form name.   The main forms in the program 
are as follows: 
 
TDocMainForm  
The main form for Docs2Manage. 
 
TDocPagesForm 
The form that displays the individual pages in a document. 
 
TDocInfoForm 
The form where document information is displayed or entered. 
 
TDocSearchForm 
The main search form. 
 
To add a new language 
1) Make sure you have selected "User Defined" language in the Configure 
Docs2Manage program.   
2) Open the Dictionary program in the "Docs2Manage" program group under the "Language 
Translations" folder.   
3) Move the cursor through the table to the blank "User Defined" column.   
4) Under the "Tools" menu select "Translate Language".   
5) Select the "SYSTRANBox" translation service. 
6) Under the "Source Language" section select "English" for both "Name in the Dictionary" and 
"System Name" fields. 
7) Under the "Target Language" section make sure "User Defined" is selected for the "Name in 
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the Dictionary" field and select the Language you desire to translate the English to in the "System 
Name" field. 
8) Click Okay to begin language translation. 
9) Save the dictionary using "File" -> "Save" menu option. 
10) Close the dictionary program. 
11) Now open the Translations Tables program in the "Docs2Manage" program group under the 
"Language Translations" folder. 
12) Highlight the "D2MLang.sib" node on the top left. 
13) Under the "Dictionary" menu click "Auto Translate". 
14) Select "English" as the base language. 
15) Uncheck the "Overwrite existing items" check-box or check this field if you are updating the 
translation tables. 
16) Click Okay and the translation tables will be populated with the contents from the dictionary. 
17) Save the translation table using "File" -> "Save" menu option. 
 
To edit an existing language 
1) Open the Translations Tables program in the "Docs2Manage" program group under the 
"Language Translations" folder 
2) Identify the form that has the translation you want to edit. 
3) Look for the named control under Captions that has the translation you want to edit.  If you 
cannot locate the control, try to identify caption the value of the string.  If you still cannot find the 
word or phrase you want to edit, you may want to look at the Strings to see if you can identify the 
translation you want to edit. 
4) Once located, edit the column of the language you desire to change. 
5) Save the translation table using "File" -> "Save" menu option. 
 
NOTE: Please contact Docs2Manage support if you need help finding a certain form or string in 
the Docs2Manage program. 
 
Below is an example of Docs2Manage with the "File" menu open with the language set to Italian: 
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Selecting a Theme 
From the View menu, select Select Theme. 
 
Customize the look of the Docs2Manage (D2M) user interface (windows, buttons, etc.) by using a 
theme.  You may select from one of the predefined themes or add your own by adding the 
D2MTheme.skn file to the Docs2Manage installation directory.  Please visit 
the www.docs2manage.com website for information on how to create your own theme. 
 

 
 
NOTE:  The next time D2M opens, the user interface will revert back to the default theme.  To 
make this setting permanent, set the theme in the Configuration program.   
 
 

http://www.docs2manage.com/
http://www.docs2manage.com/
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Thumbnails 

 
 
Thumbnails are a miniature representation of a document or image. 
 
The Documents Page form has a Thumbnail View of all the pages in a document.  Alter the 
thumbnail size by using the Page Pop-up Menu.  Select from three sizes:  small, medium, and 
large.  Default is medium.  The repository view can also view pages in the form of thumbnails.  If 
you double-click a thumbnail, the full-screen representation of the page will display. 
   
D2M New User Configuration Wizard 
When you run Docs2Manage (D2M) for the first time, the New User Configuration Wizard will 
automatically run and guide you through basic configuration of D2M.  Follow the instructions in 
the wizard to select a D2M version, industry (to customize the categorizing fields), and database. 
 
You may also find the Wizard under the Help menu, Show New User Wizard. 
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Welcome Screen 
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Select your Industry and Customize the Search and Entry Fields  

 
 
1.  Select an industry that most closely matches your organization.  Default values will be 
populated for the Search and Entry fields based on the selected industry.  Keep in mind that D2M 
also uses a document explorer like Windows Explorer where you can create an unlimited number 
of folders and sub-folders, so you might want to limit the number of classifying fields to limit the 
amount of work in adding new documents. 
2.  Customize the caption names (the display name in D2M) and field types, if desired. 
 
Field type options include: 

•  Drop-down Combo Field - select a value from a list, making searching and entry easier 

•  Standard Edit Field - enter value in a text box; use when data entry could have an infinite 

number of values (example: invoice number) 
•  Hide Field - do not display field if not needed 
 
NOTE:  The industry portion of this wizard only configures the security group you are currently 
logged into.  If you would like to use this wizard to customize other groups, change the group first, 
and then run the industry portion of the wizard.   
 
Select your Database 
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This allows you to either start using the production database, which includes any changes to the 
fields in the D2M portion of this wizard or view the sample database filled with sample documents 
to see how the search and other features work against a database that already contains 
documents.  Any changes you made using the D2M portion of this wizard will still be saved, but 
will not show unless you Change Databases or re-start D2M to enter the D2M primary database. 
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Finish and Apply your Changes 

 
After you have visited all of the tabs in the wizard, the "Finish" button will become 
active.  IMPORTANT: You must click the "Finish" button to apply your changes or you will 
have to run this wizard again.  Make sure the "Don't show this screen again" check box is 
unchecked if you want to see this wizard on the D2M start-up again.  Click "Cancel" if you do not 
want to apply your changes you may have made. 
 
NOTE: Clicking the "Show New User Wizard" under the D2M Help menu will run this wizard 
again, but with some limitations. The "Don't show this screen again" check box will NOT appear in 
this mode (as pictured) and you will NOT be allowed to change databases from this view as that 
option can be found under the File menu, by selecting Change Databases.  
 
Security and Docs2Manage 
Security Event Logging (new feature in D2M) 
Docs2Manage (D2M) can track and report virtually every activity in the program using event 
logging.  D2M has defined nearly 40 tasks, or "rights."  You can decide which rights to log using 
the Rights, Roles, and Security Event Logging Form under the Security menu.  Select from two 
reports that display the logging activity. 
 
Integral Security in Docs2Manage (formerly DSS) 
Starting in DSS Version 4.x, DSS began support of integrated security. 
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•  You define security groups, which act as their own "virtual" database for each department in 

an organization.  Each group can customize the D2M categorizing fields to fit each group's or 
department's needs. 
•  The D2M program was divided into nearly 40 tasks, or "rights."   A collection of rights makes 

up a role.   
•  You create users, assign the users to a group(s), and assign different roles to the different 

users in the group.  The user inherits the rights that are defined for the role they are assigned to 
in a group.  D2M has the capability to add or revoke individual rights for a specific user for further 
customization. 
•  Users with restricted rights will not be able to access the associated features in the program. 

•  The D2M users are stored in the database and using the same user names as the database, 

which require the program and the database to have proper corresponding rights in both D2M 
and on the database server.   
 
Read Rights, Roles and Event Logging, Groups and Users, and Joining Users to Group / Special 
Rights sections for more information on how to implement security in D2M. 
 
Database Security 
D2M uses the database user access rights to permit or deny usage to data stored in D2M.  For 
example, consider two database users named "Full" and "Reader."  "Full" has full rights to the 
D2M tables and "Reader" only has rights to only read the D2M database or tables.  You can 
configure D2M workstations to use these different database users.  Regardless of the rights given 
to a user in D2M, the database ultimately controls what a user can do. 
 
D2M may be configured to force users to enter in a password when D2M is opened.  Configure 
the database connection in the Configuration program and make sure that the Password Saving 
option is unchecked.   
 
Document Locking 
Lock a document to limit other users from editing that document.  There are two types of locks: 
 

•  Public Lock - Anyone with the public lock right (CanLockPublicDoc) in that group can unlock 

the document. 
•  Private Lock - Only the user that set the lock can unlock the document. 
 
Click the Lock Toggle button on the main toolbar to lock/unlock a document.  While the 
document is locked, only the user that locked the document can edit the document. 
 
NOTE:  Either lock type can also be broken by a Docs2Manage System Security Administrator.  
 
 
Controlling Docs2Manage Using Other Programs - Parameters 
Docs2Manage (D2M) allows other programs to pass parameters to control the software.  These 
parameters control how D2M opens, views data, searches for records, or adds new records.  
Currently, the only known software with compatible with D2M is a contact management software 
by Chaos Software called !ntellect also known as Time and Chaos. 
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Find the file named "services.ini" in the !ntellect or Time and Chaos software install directory 
(usually C:\Program Files\Chaos Software\Intellect or C:\Program Files\Chaos Software\Chaos 
#).  This file stores how !ntellect or Time and Chaos will pass parameters to D2M.  Open this file 
in a text editor and look for the following section: 
 
!ntellect and Time and Chaos 7.0 
[Docs2Manage:] 
Commandline=C:\Program Files\COMvantage\Docs2Manage\Docs2Manage.exe 
Parameters="NCV" "X" "X" "'FUNC=InsertIfNotFound','DOCFOLDER=«6» 
«1»','IMPORTANCE=«2»','DAYSOFHISTORY=365','VIEW=Best','ISMAXIMIZED=False','Supre
ssComboMsg=True'" 
 
Older versions of Time and Chaos 
[Docs2Manage:] 
Commandline=C:\Program Files\COMvantage\Docs2Manage\Docs2Manage.exe 
Parameters=NCV X X 'FUNC=InsertIfNotFound','DOCFOLDER=«6» 
«1»','IMPORTANCE=«2»','DAYSOFHISTORY=365','VIEW=Best','ISMAXIMIZED=False','Supre
ssComboMsg=True' 
 
The « and » surround !ntellect or Time and Chaos fields.  These fields are filled in based on the 
current contact record you are on in the software.  Refer to the "fields.ini" file to retrieve the field 
number that corresponds with the field(s) you want to pass to D2M.  For example, «6» is first 
name and «1» is the last name, so «6» «1» is the full name.  
 
D2M Parameters and Commands 
The first parameter controls the splash screen.  The possible values with the effects in 
parenthesis are  
•  NCV (hide the COMvantage splash screen to give the effect that D2M is part of the application 

calling D2M) 
•  SPLASH (will display your custom splash if designed) 

•  CV or any other value (shows the normal splash screen) 
 
The second parameter are always set to X (used for internal purposes). 
 
The third parameter is the language Docs2Manage will use.  Set this value to X or Default to 
ignore this setting.  This parameter can be set to one of the following languages: 
English 
German 
French 
Russian 
Italian 
Spanish 
Portuguese 
Chinese 
Dutch 
Japanese 
Arabic 
User Defined 
 
The fourth parameter controls the core of what D2M will do.  Each sub-section of this section of 
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parameters should be surrounded by single quotes, separated by commas, and the equal symbol 
separating the command from the value.  The commands are listed below in bold and underlined 
and the values are italicized with the effects in parenthesis. 
 
DBNUM 
1 (D2M default - opens D2M to the first or primary database connection) 
2 (opens D2M to the second or secondary database connection) 
Any valid numbered database connection 
 
FUNC 
SEARCH (D2M default - searches based on the criteria fed via other parameters - no action if 
search finds no records) 
INSERT (inserts based on the criteria fed via other parameters - does not search first) 
INSERTIFNOTFOUND (recommended - works like SEARCH value, but inserts if search finds no 
records) 
 
VIEW 
FORM (D2M default - always brings up D2M in form view mode) 
GRID (always brings up D2M in grid view mode) 
BEST (recommended - if the search returns one or no records then from view, if more than 1 
record then grid view) 
 
SHOWDOC 
FALSE  (D2M default - does not automatically pop-up document pages form after successful 
search) 
TRUE (automatically pops-up document pages form after successful search) 
 
 
SUPRESSCOMBOMSG  
FALSE (D2M default - if the new value being inserted in a field that is defined as combo will ask 
for confirmation to add to combo value list) 
TRUE (recommended - assumes new combo values will be added to list of values for future use) 
 
ISMAXIMIZED  
TRUE (D2M will open maximized) 
FALSE (recommended - D2M will open as window giving the appearance of being part of the 
calling program) 
 
Database field to be searched (or inserted) 
KEYWORDS (this searches all fields and OCRed data for words separated by spaces.  Follows 
search options on search screen.  For searching only - will not be used as insert values.) 
DAYSOFHISTORY (this create a date range based on the DATEOFDOC.  For searching only - 
will not be used as insert values.) 
DAYSINFUTURE (this create a date range based on the DATEOFDOC.  For searching only - will 
not be used as insert values.) 
DATESTART (beginning date used based on the DATEOFDOC.  For searching only - will not be 
used as insert values.) 
DATEEND (ending date used based on the DATEOFDOC.  For searching only - will not be used 
as insert values) 
DATEOFDOC or 1 (date used to insert in the DATEOFDOC field - not used for searching) 
DATEENTERED or 2 (date used to insert in the DATEENTERED field - not used for searching) 
IMPORTANCE or 3 (search and/or insert field) 
DOCFOLDER or 4 (search and/or insert field) 
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DOCSOURCE or 5 (search and/or insert field) 
DOCENTITY or 6 (search and/or insert field) 
DOCTYPE or 7 (search and/or insert field) 
DOCREF or 8 (search and/or insert field) 
DOCTREE_ID (Unique value given to each node in Document Explorer.  For searching and/or 
inserting values.) 
DOCTREENODENAME (This first search the Document Explorer folders to see if the given folder 
name is unique.  If not an error is displayed, but if it is unique then it is used for searching and/or 
inserting values.) 
 
TIP:  If you are not sure what the underlying field name or number is, switch to D2M's form view, 
click and set focus on the desired field in question, and press the <F12> key.  D2M will display 
the underlying field name and field number.  It is preferred to use the field number rather than the 
field name, since application parameters can only be 255 characters in most Windows operating 
systems. 
 
Example:  Test the use of application parameters with the desktop short-cut to D2M.  Right-click 
the D2M program short-cut, choose Properties, click on the Target text box to set focus, go to the 
end of the path and add a single space and the following: 
NCV x x 'DOCFOLDER=Thomas Zander','KEYWORDS=skylight 
yard','DATESTART=10/6/1990','DBNUM=2','SUPRESSCOMBOMSG=True','FUNC=INSERTIFN
OTFOUND','VIEW=BEST' 
This should open up D2M to the real estate example database and find the appropriate record.  
 
Image Formats Supported by Docs2Manage 
Tiff 1-bit Black & White - Industry Standard for general Document Management 
B&W Tiff image format probably offers the best overall document quality where color and shade 
are unimportant.  B&W Tiffs are very efficient for storing documents because D2M uses CCITT 
compression methods that only store the actual black pixels.  B&W Tiff imaging allows D2M to 
use high-speed scanners efficiently because the image transfer from the scanner to your 
computer is much smaller (as long as the scanner is capable and set to scanning in B&W mode).  
This image type does not have any image quality loss like Jpeg compression.  The only loss is 
shades that are determined to become just black or white, which can also give the image a 
speckled appearance.  To combat this, your scanner should be set B&W mode and the highest 
contrast allowed.  You also might want to adjust the brightness on your scanner somewhat high 
to achieve better results. 
 
Jpeg 
Jpeg is a full spectrum RGB color format that uses a compression scheme that greatly reduces 
the size of a color image.  Too much compression will reduce image quality.  It is recommended 
to set to 85% quality, but depending on your needs, moving this higher or lower may be 
necessary.  For best scanning results, please set your scanner's contrast and brightness in the 
middle range. 
 
Tiff 8-bit Grayscale 
Grayscale imaging maybe the best option when the shade of black is important like in X-rays, 
some legal documents or for black and white photos.  This type of Tiff is stored using Pack Bits 
no loss compression and then zipped into the database to save more space.  For best scanning 
results, please set your scanner's contrast and brightness in the middle range.   
 
PNG - Portable Network Graphics  
24-bit RGB Color- This can be used in place of Jpeg scanning when image quality loss is not 
acceptable.  Keep in mind these image sizes can be very large, so you might consider using Jpeg 
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with a 90% or higher quality level, which should not show any noticeable quality loss. 
8-bit Indexed color (256 Colors)- This may be a good choice when some color loss is 
unimportant, but when image quality loss is not acceptable. Like 24-bit PNG images these image 
sizes can be very large, so you might consider using Jpeg with a 90% or higher quality level, 
which should not show any noticeable quality loss. 
8-bit Grayscale- This will work almost exactly like Tiff 8-bit grayscale, but depending on the 
documents you are scanning, may have a smaller image size and faster image loading 
performance during scanning and viewing since the extra step of zip compression is not 
necessary. 
For best scanning results for all PNG image types, please set your scanner's contrast and 
brightness to somewhere in the middle. 
 
Importance of Scanner Resolution 
In general, 200 to 300 dpi is best for most document management needs.  Scanning images at a 
higher resolution may cause scanned document sizes to become very large, but maybe 
necessary in some cases.  Please test different resolutions on the screen and by printing 
scanned test documents to see what works best. 
 
TIP:  Please tests all the image formats available.  Please also note that the image type you use 
will have the greatest impact on scanning speed.  Only try to use image color level you need.  
Hence, if you are only scanning B&W documents, use 1-bit B&W Tiff. 
 
Document Template Support 
Docs2Manage 2.0 added the ability to add new documents from templates.  This eliminates the 
need to manage templates and edit new documents using these templates outside the system.  
The templates are stored in Docs2Manage or can be linked to a file on a system or network.  A 
template should be a document that can be edited like an Adobe Acrobat (PDF), MS Word, or 
Excel document.  This could be a completely blank document, or a document made to fill in the 
blanks.  Your computer should have software installed on it to allow you to edit the document.  
For example, if you add a template made with MS Word, then you should have MS Word installed 
on any machine that will use that template. 
 
Create a document from an existing template 
To add a document from an existing document template, click the "New Document from 
Template" button or press F3 and select a template from the template dialog.  Once a template is 
selected the Document Information Form will display with the information filled in as defined for 
that template.  Finally, once you save the document information, the document template will open 
for editing.  Change that document as desired.  This will NOT affect the underlying template.  
Once you are finished editing the document, save and close the program that was used to edit 
the document.  Be sure to save the file using the name that Docs2Manage has defined (use 
"Save" and not "Save as..").  This will save the document into Docs2Manage. 
 
Add a document template to Docs2Manage 
The Template Set-up screen can be accessed by clicking the "File" main menu and then 
"Document Templates Set-up".  The following screen will appear: 
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To create a template, click the "New Template" button.  Type in a name and description for the 
document.  If the document is for private use only, then make sure the "Private to user only" field 
is checked or else it will be public to the group.  Next, click the "Add Document and Make Active" 
button to select the file and the following dialog will appear: 
 

 
 
If you elect to store the link ("Store Link"), Docs2Manage will always look for the template from 
the location you provide.  If the template is to be considered public, you will want to select the 
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template from a common shared network drive.  If you elect to store the document in the 
database ("Store in Database") the document template will be available to anyone that has right 
to the template area, but only if it is marked as public. 
 
Under the "Default Data Values" section, this is data that can be copied to the information record 
when the document template is used to create a new document. 
 
When you are finished, click the "Update" button to finish adding the new template. 
 
NOTE: Document templates stored in the system are not changeable.  If you need to modify an 
existing template, open the template and save a new copy to a file, edit that copy, copy it to the 
share area of your network if Docs2Manage is going to store the link, and re-add the document 
template to the system using the "Add Document and Make Active" button.  
 
Docs2Manage Printer and Printer Capture Mode (TO BE 
DEPRECATED) 
This functionality is pending removal, as it will not work with Windows 7 or higher.  We are 
researching a replacement for a future version of D2M. 
 

 
 
Docs2Manage (D2M) has a way to capture printed documents through a D2M printer.  This 
eliminates the need to print documents on paper and then scan them into D2M.  This D2M Printer 
can be installed while the D2M software is being installed or via the D2M Config program.  This 
printer can be shared on a network to allow many users to add documents to D2M at the same 
time. 
 
The D2M Printer can only capture print jobs in black and white.  For all editions, 1-bit B&W tiff is 
the recommended capture setting.  More information about this setting can be found in the D2M 
Printer Image Capture Format section. 
 
To use this option, select Print Capture Mode under the File menu in D2M. 
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Once you have confirmed that the Printer Capture Mode can begin, D2M will minimize and start 
capturing any print jobs sent to the D2M printer.  The D2M printer ignores jobs when D2M is not 
in Printer Capture Mode. 
 
To quit Printer Capture Mode, simply click the running instance of D2M on the task bar to restore 
the program.   Answer No when D2M asks if you would like to continue in Printer Capture Mode. 
 
NOTE:  Only one instance of D2M in printer capture mode is allowed on a single system or 
computer. 
 
Repository Set-up Dialog and Mode 
Repository Mode 
As an alternative to classifying documents one at a time, the repository gives you a place to scan 
or add your unorganized document to a staging area.  Think of this staging area as a "virtual" in-
box for the many different sources where documents flow into your organization.  You can create 
as many of these repositories as you need, and they can be named differently per each 
Docs2Manage (D2M) installation.  This idea lends itself to high-speed document scanners that 
can scan many pages at one time and be digitally organized later. 
 
Repository Set-up Dialog 

 
 
To create a new repository: 
1. From the File menu, select Repository Set-up.   
2. Find a Repository Number where the name is indicated as "** New Repository **". 
3. Rename the repository Name to something meaningful to you (e.g., "Personal" or "Business"). 
4. Select a Group Owner.  This field is only active to the System Security Administrator (SSA) 
and indicates to which security group the repository belongs.  The SSA is the only role that can 
create or modify Public repositories (repositories which can be viewed by anyone in Repository 
Mode). 
5. Click the Create New button. 
 
Once a repository is created, you can rename a repository in the Repository Set-up Dialog by 
changing the name text click the Post Updates button. 
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WARNING: Although it is possible to use a different storage type and location for each security 
group, it is highly recommended to keep the storage type and location the same for all groups.  If 
you elect to have different storage types or locations in a single database, you will not be able to 
view other repositories that have a different storage type or location even though you may have 
right to those repositories in other groups.  Also, avoid switching an existing repository from one 
group to another if they have different storage types or locations.  These conditions and warnings 
do not apply if you use the same storage type and location for all groups. 
 
NOTE:  Repository names are stored on each machine, so they can be named whatever you 
like.  Other D2M users will not see this name but can view the contents of the repository.  If a 
user goes into a repository that does not have a name on that computer, the name will be "*** 
Unknown Repository ***". 
 
You can create up to 999 different repositories. 
 
Entering a Repository 
To enter a repository, click the Enter/Make Default button.  Selecting a default repository allows 
you to automatically enter that default repository when you select Repository Mode under 
the File menu. 
 
Using Repository Mode 
Once you have entered Repository Mode, the main form's caption will indicate that you are in 
Repository Mode.  This mode is just like using D2M in regular mode, but you can add as many 
unrelated documents as you want to the selected repository record with the intention of moving 
those documents out of the repository to new documents later.  This means if you have a 
document scanner with an Automatic Document Feeder (ADF), you can load and scan all your 
varying documents at one time without needing to stop the scanning process to change or create 
the next D2M document information record. 
 
Once you are ready to organize the repository pages, you can move selected document pages to 
a single document or move many pages into many single page documents.  This can only be 
done from repositories that are considered active (your current security group / shown in blue).  
The Documents Page Grid View has a pop-up menu to make document page selections and 
options to transfer pages to new documents.  This process is described in detail in the Repository 
Page Pop-Up Menu) section.  If the documents you desire to classify are in a public repository 
(shown in red) or in a different group (shown in black), you must first move those pages you 
desire to classify to an active repository, as described below. 
 
Moving Documents from One Repository to Another 
Once in repository mode, all the active repositories are displayed in a tree view on the left side of 
the screen.  The number next to the repository name indicates how many pages are in each 
repository.   The Document Pages / Files section in the upper right corner displays thumbnails of 
the pages.  You may switch to a Grid View by right-clicking the mouse to display a pop-up menu.  
Pages in the tree view or Thumbnail/Grid View can be selected, dragged, and dropped into 
another repository on the tree.  Please read the Workflow & Repository Tree View about this 
topic.  
 
An Overview of Security Event Logging 
Event Logging has been added to the first release of Docs2Manage (D2M).  This gives the ability 
to log almost every major function and process in D2M including adding or changing documents, 
viewing or printing documents, and just about every other feature available in D2M.  Since these 
rights control what all users can do in D2M, it made logical sense to log whenever a user 
accessed one of these rights whether directly or indirectly.  Logging a certain right can be turned 
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on or off by checking or unchecking the "Log this Event" field on the first tab of the Rights, Roles, 
and Security Event Logging form.  You can change the log detail description of the right accessed 
and how will be recorded for each right in the system.  Also keep in mind that the option to log a 
right or to customize the log description for a specific right is used for all security groups in the 
same database.  Regardless of the log description, D2M also records the date and time, the right 
name accessed, security group, document ID, and page number that was affected by the event or 
action. 
 
This logging information is stored in the D2M database in the DOCUSERLOG table.  This 
information can be accessed from the View and Report Security Event Log form.  This area 
allows you to search by date, security group, user, right accessed, or document ID.  The results 
of a search can be printed in the form of a report.  If you desire, older or unneeded logging 
information can be purged within that form.  
 
Workflow & Repository Tree View 

 
Tree View 
In repository mode, all the active repositories are displayed in a tree view on the left side of the 
screen.  The number next to the repository name indicates how many pages are in each 
repository.  Nodes in the tree can represent different agents that will sort through documents or 
possibly different steps a document goes through before it is stored as a document accessible 
through a Docs2Manage (D2M) search. 
 
For example, the first node or repository could be named "Scanned pages" and the other 
repositories might be named "Joe's Inbox", "Tom's Inbox", and "Paul's Inbox".  One person may 
oversee scanning all new documents into the "Scanned pages" repository and then that person 
may pass those documents or pages to the other relevant repositories.  From there, each person 
handles their own documents by sorting, categorizing, and filing them into D2M Documents, 
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which can then be searched in the future.  On Joe's machine, he may call what was called "Joe's 
Inbox" to "My Inbox" and set that to be his default repository.  The names given to each repository 
are unique to that machine as determined by the Repository Set-up.  It may be a good idea to 
also have a repository to handle print jobs from the D2M Printer. 
 
Moving Documents from one Repository to another 
Pages in the tree view or page grid can be selected (by using the <Shift> or <Ctrl> keys while 
selecting those pages with a mouse), dragged, and dropped into another repository on the tree.  
This is a good way to assign pages to another party's repository. 
 
Workflow Updates and Refresh 
D2M can refresh the documents in each repository by setting the Repository Refresh 
Rate referred to in the Workflow Options section.  This allows you to see changes in the 
repositories as people process and move documents from one area to another.  This is most 
evident by the number indicated next to the repository name (the number of pages in the 
respective repository). 
 
WARNING: Although it is possible to use a different storage type and location for each security 
group, it is highly recommended to keep the storage type and location the same for all groups.  If 
you elect to have different storage types or locations in a single database, you will not be able to 
view other repositories that have a different storage type or location even though you may have 
right to those repositories in other groups.  Also, avoid switching an existing repository from one 
group to another if they have different storage types or locations.  These conditions and warnings 
do not apply if you use the same storage type and location for all groups. 
 
Docs2Go Portable Archive - CD Mode - Distributing your Data 
Docs2Manage (D2M) can produce a CD/DVD that can be autorun directly from Windows PC 
CD/DVD drive without an install or license.  Please refer to Backing up the Database / Running 
D2M from a CD-ROM on how to create a CD-ROM using this option. 
 
This may be useful to create portable backups which can be run on any Windows machine or to 
send a client a snapshot of documents related to their account.  You can decide if you want to 
make an archive with your entire database or just based on your current search criteria.  The 
recipient's only requirement to run Docs2Go from the CD-ROM is to insert a valid Docs2Go 
archive CD/DVD into the recipient's CD/DVD drive running Windows.  The Docs2Go Archive will 
autorun and display as a read-only version of the product without a need to install D2M first.  
None of the editing features are visible or active.  Other than that, you may distribute these CD-
ROMs freely. 
 
You can even design your own splash screen so the Docs2Go distribution CD/DVD will run 
looking like your own company's creation.  Please refer to Creating and Using Your Own Splash 
Screen for how to build and add a custom splash screen. 
 
NOTE: When a CD archive is created, Docs2Manage copies the information to an MS Access 
database which is the only usable database format to use on a read-only CD-ROM.  MS Access 
has a 1 GB database size limitation.  If your documents database is stored embedded in the 
database, you will only be able to store 1 GB of documents and data in the database (around 
10,000 to 50,000 pages).  By setting up Docs2Manage to store the documents in a file format, 
then the database will only be used for data and documents will be store in a "Docs" directory on 
the CD-ROM or DVD-ROM media.  The database will have much more room to store data that is 
used to classify the document and a DVD can store up to 200,000 to 300,000 pages.  In either 
case the back-up process will fail if the database exceeds 1 GB.  Please test the size of the 
archive using the "Estimate Archive Size" button. 
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Reporting and Exporting Document Information 
From the File menu or Main Toolbar, select Print or Export Document Info in Grid. 
 

 
 
This feature allows you to preview, print, or save a text file based on the content from the main 
form's grid. 
 

 
A Sample Report Preview  
 
Backing-up the Database / Build a Docs2Go Archive Dialog 
Creating a Back-up Through Docs2Manage 
In either version, you can backup part or your entire database to an MS Access file.  This also 
gives you the ability to write this database file to media like a CD-R where it can be accessed 
directly from a CD-ROM drive.  You can even distribute your data and D2M on a CD-ROM 
using CD Mode for free, also called Docs2Go. 
 
From either the CD icon on the main toolbar or under the File menu, select Back-up D2M 
Database > to MS Access file / Create Autorun CD Rom.   
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Back-up Options 
 
Record Options 
•  Use Current Filter - only backs up the records applied with the current filter from the search 

screen.  This may be desirable if you want to distribute the database for a customer's account. 
•  All Records - performs a back-up of the entire database regardless of current filter settings. 
 
Tree Options 
•  Only Copy Used Portion of Tree - only backs up the used portion of the tree view and the 

parent folders of the folders that are used 
•  Copy Entire Tree Structure - performs a back-up of the entire tree structure 
 
Location to write D2MArc.mdb file and related files (Back-up Location)- select the target 
location or directory for the back-up.  This is still necessary even if you elect to "Burn to Disc after 
Back-Up is Complete" as a location where files are temporarily stored for the CD/DVD creation 
process. 
 
Include necessary program files with back-up to create Autorun CD-ROM distribution, 
which can be distributed freely:  Check this option if in addition to the MS Access file, you want 
all the files necessary to run D2M directly from an autorun CD-ROM.  These CD-ROMs can be 
used on any Windows computer without D2M being installed.  
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Include files for custom splash screen:  Check this option if you want to override the default 
splash screen with your own designed custom splash screen.  To design a custom splash screen 
click the "Design Custom Splash" button and refer to Creating and Using Your Own Splash 
Screen for more help. 
 
Estimate Archive Size: This feature attempts to estimate the amount of space that will be used 
in your backup.  It does account for the necessary files if the D2M CD-ROM checkbox if selected.  
This operation is not as lengthy in time as the actual backup and will reasonably predict the size 
of the back-up. 
 
Burn Existing Back-up to Disk!: This feature assumes you already made a back-up and that 
back-up is stored in the configured "Back-up Location".  This may be a good option to use rather 
than "Burn to Disc after Back-Up is Complete", which copies and burns the files created in the 
back-up process immediately after the back-up is complete. This will allow you to add other files 
that may not be part of your back-up. 
 
Back-up button: Click to begin the back-up operation, which will also be followed by the burn 
CD/DVD process if elected.  The Back-up Progress bar tracks the current status of the back-up.  
Following the back-up process, the Burn-to-Disc Progress bar tracks the current burning to Disc 
process.  A message will be displayed when the back-up and/or the burn to CD/DVD process is 
complete. 
 
NOTE:  The autorun CD Mode option should work on any machine with MS MDAC installed.  
Earlier versions of Windows 98 and Windows 95 may require a manual install of MDAC for D2M 
to run properly.  This can be downloaded directly from Microsoft site from Microsoft MDAC 
Download Page. 
 
ALSO NOTE: When a CD archive is created, Docs2Manage copies the information to an MS 
Access database which is the only usable database format to use on a read-only CD-ROM.  MS 
Access has a 1 GB database size limitation.  If your documents database is stored embedded in 
the database, you will only be able to store 1 GB of documents and data in the database (around 
10,000 to 50,000 pages).  By setting up Docs2Manage to store the documents in a file format, 
then the database will only be used for data and documents will be store in a "Docs" directory on 
the CD-ROM or DVD-ROM media.  The database will have much more room to store data that is 
used to classify the document and a DVD can store up to 200,000 to 300,000 pages.  In either 
case the back-up process will fail if the database exceeds 1 GB.  Please test the size of the 
archive using the "Estimate Archive Size" button. 
 
Backing-up Manually (Outside of D2M) 
MS Access Database:  To back-up the MS Access database, simply copy the correct .mdb file to 
a safe storage device or media.  This media could be a CD-ROM, which can be accessed by 
D2M in read-only mode.  Be sure that no one is currently accessing the file during the copy, or 
you may not be able to copy the file. 
 
Enterprise Databases:  Please consult with your database administrator about your 
organization's back-up policies and procedures or your database's documentation back-up 
procedures.  Also, you may copy your database to an MS Access database (file). 
 
NOTE: Beginning with Docs2Manage 2.0, Docs2Manage can store files and documents separate 
from the database.  Please include that file directory as part of your back-up schedule along with 
the database back-up. 

https://www.microsoft.com/en-us/download/details.aspx?id=5793
https://www.microsoft.com/en-us/download/details.aspx?id=5793
https://www.microsoft.com/en-us/download/details.aspx?id=5793
https://www.microsoft.com/en-us/download/details.aspx?id=5793
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Creating and Using Your Own Splash Screen 

 
 
You can now create your own custom splash screen to distribute your Docs2Manage back-
ups/filtered archives onto a royalty-free distribution CD/DVD with your own splash screen image 
and text. Please read Backing-up the Database / Build a CD-Rom Archive Dialog to understand 
how to do this.  This section will only address how to create your own custom splash screen. 
 
By default (or if you answer "No" to load the default after clicking the "Design Custom Splash" 
button on the Create Back-up CD form) the Docs2Manage splash screen image will display in the 
image area of the form.  This image and 4 configurable labels can be changed.  However, the 
light yellow/tan colored region below the image cannot be changed.  This area has the most basic 
information about Docs2Manage including the product name, edition, version, build date, and 
copyright info. 
 
Select a Splash Screen Image 
To change the splash image, click the "Load Splash Image" button.  This will open a file picker 
dialog, which can only accept JPEG images with some dimension restrictions.  The height must 
be between 150 and 400 pixels, and the width must be between 325 and 600 pixels.  Please 
design your own image using a suitable image or graphic software that allows you to design a 
JPEG image.  MS Paint will work, but it is rather limited in terms of the look you can create.  Once 
you select a suitable image, it will display in the image area and the light yellow/tan colored 
region below the image will stretch to fit your image. 
 
The Splash Screen About Form "OK" Button 
This button only displays when the splash screen is opened as an about screen via Help -> About 
from the main menu.  The button is required and is needed to close the About form.  The button 
can be found inside your custom splash screen image.  You can move it anywhere inside that 
image by simply dragging and dropping it where you desire. 
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Splash Screen Labels - Labels 1 through 4 
There are up to 4 labels you can add to the image area of your splash screen, once again the 4 
lines of labels in the light yellow/tan colored region cannot be changed or removed. First decide 
how many labels you want to have.  You can hide or display the labels by clicking the "Is Visible" 
check-box, so if you only want 1 label, you can uncheck "Is Visible" for labels 2 through 4. 
 
Besides the "Is Visible" check-box, each label has 4 properties- they are Font, Color, Label Text, 
and URL.  You can also drag the labels anywhere in the image area to change the position.  It 
would be best to finalize your image first, because changing the image after the labels are 
designed may cause the position of each label to reset. 
 
Note: By default, the font color is black.  If your splash screen image is black or is dark in color, 
you may not see the labels.  If this is the case, you may want to change the font color to white as 
a starting point, so you can see the labels. 
 
Font (Font, Style, and Size) 
If you click the "Set Font" button for any of the 4 labels, a font selection dialog will appear where 
you can change the Font, Style, and Size one label at a time. 
 
Color 
If you click the "Set Color" button for any of the 4 labels, a font color selection dialog will appear 
where you can change the Font Color. 
 
Label Text 
Enter the text for each of your labels into the input box for each label and you should see the text 
change on the splash screen preview area. 
 
URL 
Enter a fully qualified URL in this field, which should include http:// or https:// for a web link and 
this link will become active on your custom splash screen (although the splash displays very 
briefly upon application start up) and on the about screen, which is just like the splash screen, but 
remains open until the user closes it.   
 
Test (URL) button 
The test button will become active for any fully qualified URL that begins with http://, https://, ftp://, 
mailto:, and tel:  Clicking this button will test the URL.  At this point no other fully qualified URLs 
are allowed for security purposes.  We are open to suggestions in the future. 
 
Load Previously Designed Splash (Undo) button 
Clicking this button and agreeing to not save your pending changes, will rollback all changes 
since the last time a custom designed splash screen was saved. 
 
Save Splash Screen Settings / Preview button 
This button will save all pending changes to your custom designed splash screen.  After it is 
saved, the preview screen will display in the form of your "About" form.  Click the "OK" button on 
that form to close the preview.  Once again, the "OK" button will not display on your custom 
splash screen as the program loads, but only in your "About" form, which to your end-user is only 
accessible from the Help -> About from the main menu. 
 
OK (Exit this form) button 
This button will close the design splash screen form, however, if you have any unsaved changes, 
you will be prompted to save or cancel those changes before the form closes.  If you elect to save 
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the changes, you will also be shown a splash screen preview.  Click the "OK" button on that form 
to close the preview. 
  
Database Migration 
Docs2Manage can migrate your existing database to another different database with the 
Database Migration Utility accessible from the "File" main menu "Back-up or Migrate Database" -
> "Database Migration Utility".  This could be used to migrate a MS Access Database to another 
server type like MS SQL Server or Oracle.  This utility assumes that you have created the 
database tables in the destination database using the provided script in the "Docs2Manage" 
program folder "Database Scripts" folder.  Please read the Database Support, Scripts, and 
Modifying Docs2Manage Tables section of this help file to learn how to install the tables 
Docs2Manage needs. 
 
Database Migration Utility 

 
 
Database Migration Options 
 
Record Options 
•  Use Current Filter - only backs up the records applied with the current filter from the search 

screen.  This may be desirable if you want to distribute the database for a customer's account. 
•  All Records - performs a back-up of the entire database regardless of current filter settings. 
 
Tree Options 
•  Only Copy Used Portion of Tree - only backs up the used portion of the tree view and the 

parent folders of the folders that are used 
•  Copy Entire Tree Structure - performs a back-up of the entire tree structure 
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Select Database to Migrate to - select the database type and location of the destination BLANK 
database. 
 
Migrate in a Single Transaction - When this option is checked Docs2Manage will attempt to 
migrate the database in a single transaction.  If the migration process fails none of the tables will 
be imported and any changes will be rolled-back.  If the existing database is large it is 
recommended to not use this option, since this will greatly increase the amount of time needed to 
do the migration. 
 
Migration Options 
 
Migrate All Security - This will migrate all of the security intact including the rights, roles, security 
groups, users, and how the users may access the system.  It is recommended that this option is 
checked. 
 
Include Audit Logs - Migrate the security event log so it will remain intact in the new database. 
 
Include Repositories - This option attempts to migrate any repositories and pages in those 
repositories to the destination database.  It is recommended that this option is checked. 
 
Include Templates - Check this option if you want to migrate any template to the destination 
database.  Any links the template area uses will remain intact. 
 
Rename SSA User in New Database - Use this option to define the name of the user account 
that has rights to the new database.  For example, "Admin" is the default user name for an MS 
Access database.  If the new database is MS SQL Server the new user name should be either 
"sa" or "Administrator" (or whatever your Windows SQL Administrator user name might be) 
depending on the SQL Server authentication model; typically for Oracle the default administrator 
account is "system" and for MySQL it is "root". 
 
WARNING - If you do not use this option or fail to use it properly and the new database requires 
a different user name, you will not have the proper rights in Docs2Manage to access or use 
Docs2Manage.  This can be fixed by manually editing the SSA user record in the DOCUSER 
table. 
 
Estimate Migration Size: This feature attempts to estimate the amount of space that will be used 
in your migration.  This operation is not as lengthy in time as the actual backup and will 
reasonably predict the size of the migration. 
 
Migrate button: Click to begin the migration operation.  The migration progress bar tracks the 
current status of the migration.  A message will be displayed when the migration process is 
complete. 
  
Bulk Scanning Options Dialog 
This feature allows you to scan different documents into the Docs2Manage (D2M) database first 
and fill in the document information record later.  This may be very useful when scanning many 
documents with an Automatic Document Feeder (ADF) and when you know the exact number of 
pages per document and the documents are fully organized and in order.  If the documents are 
unorganized or have a varying number of pages, the Repository Mode maybe the better bulk 
scanning option. 
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Pages per Document:  This sets the number of pages that will belong to one document. 
 
For example, if you want to scan in a pile of two page invoices, set this option to two.  Each time 
two pages are encountered, D2M automatically creates the next record.  If the invoices vary in 
the number of pages, set this option to 0 (zero).  Each time you want a new information record, 
select Edit/View Document Info from the View menu. 
 
Reference Number Options:  This option will attempt to increment the value of the Document 
Reference field on the Documents Page by the number you indicate in this option.  For example, 
if you enter 1 in this field and 1000 in the document reference field, the document numbering will 
be 1001, 1002, etc.  If you set the value to 0, this option will be ignored. 
 
Create New Document Now:  If this option is checked, a new document will be inserted when 
the Okay button is clicked.  All the Documents Page fields will display the value "Unselected".  
Change all the fields where you know the information and leave the unknown fields as 
"Unselected."  After you have finished scanning all your different documents, you can do a search 
or filter on one of the fields you left unselected and fill in the proper information at that time.   
 
System Requirements 
Supported Operating Systems and Software 
Docs2Manage (D2M) was designed to work on Windows 95/98/Me and Win NT 4/Windows 
2000/2003/XP7/8/10. 
 
Windows 95, NT 4.0, and older versions of Windows 98 may need to have MDAC installed to use 
D2M.  D2M may display an error message indicating this failure if this is the case.  Please search 
on Microsoft's website for the MDAC download suitable for your version of Windows.  Windows 7 
and on MDAC should already be installed as part of Windows. 
 
(Optional for use with included MS Access database) MS Access 97 or greater to customize D2M 
tables. 
 
(Required for enterprise databases) You will need an ADO driver/provider that is compatible with 
the intended database.  Consult your database vendor if this is available for your database.  
MDAC 2.5 or higher comes with the ADO providers for MS SQL Server and Oracle. 
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(Optional) Image Editing software for advanced editing. 
 
(Optional) In order for you (or any other clients) to view, edit, or add any Windows Document like 
an MS Word Document, the client must have that particular software installed. 
 
Hardware 
Intel i3 processor (or equivalent) or greater 
4 GB system memory or greater- 8 GB preferred 
(Optional) Scanner or other twain image device 
(Optional) CD/DVD ROM Writer 
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Chapter 2 – Configuring Docs2Manage 
 
Configuration Overview & Registration 
The Configuration Program  
Use the Docs2Manage (D2M) Configuration Program to configure your database 
connections, image storage size, image working directory, default image editor, scanner, and 
printer settings.  Additional help is available from within the program by clicking or setting focus 
on the control or field you need help with and pressing the <F1> key.  You may also 
select What's this? from the Help menu and then click the control or field to receive specific 
help. 
 

 
Choosing the Edition Type 
Under the Registration menu, check the appropriate edition type.  To read more about which 
edition is right for you, refer to Available Editions of Docs2Manage section in this help file. 
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Registering Docs2Manage 
When you register D2M, all the limitations concerning the number of documents allowed to store 
in the system are lifted.  Also, the registration reminder will no longer appear anymore.  For more 
details on these limitations, read about The Trial Version section in this help file. 
 
First, you will need to buy a license.  Visit www.docs2manage.com and purchase the appropriate 
license.  Your license(s) will be sent to the email you used in your purchase.   
 
To register, click Enter License Code to Register under the Registration menu.  The 
registration dialog will open with 4 entry boxes (6 numeric digits per box) to enter the license you 
(or one of the licenses if you purchased multiple licenses) were given after your purchase.  Make 
sure you are connected to the Internet and click the "Register Through Web" button.  If 
successful, after a few seconds, details of your license should display in a dialog.  Then when you 
open or re-open Docs2Manage, the splash screen should display that you are a registered user. 

 
 
Transferring the License to a New Computer 

http://www.docs2manage.com/cgi-bin/d2mweb.dll/PurchaseOrder
http://www.docs2manage.com/cgi-bin/d2mweb.dll/PurchaseOrder
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You can also use the Transfer License feature if you want to transfer a license away from the 
current computer to another computer.  First, you will be warned TWICE that this process will 
delete the license from the existing computer.  After you confirm this, copy or make note of the 4-
pairs of 6 digits (your license code), which will be needed on the new computer.  After you 
transfer the license, the current computer will become unregistered.  Then that license can be 
entered into Enter License Code to Register under the Registration menu on the new 
computer.  A license can only be transferred once per each year of support.  Your initial purchase 
comes with one year of support. 
 
NOTE: Check the D2M registration status at any time by selecting Check Registration 
Status under the Registration menu. 
 
 
Database Connections 
Docs2Manage (D2M) is installed with two pre-configured database connections.  The Enterprise 
Version of D2M allows an unlimited number of database connections (and unlimited security 
groups).  All other editions of D2M only allow one connection. 
 
The connections can be modified, or new connections can be created (you can only modify due 
to database connection limitation in the trial version).  To create a new connection, click the up 
arrow on the Connection Number / Name field until you see ** Unused Connection ** in the 
connection name field.  Rename existing or new connections with a friendly name.  This is the 
name of the connection you will see inside D2M.  Click the three dots button on the right side of 
the ADO Connection String field to display the Microsoft ADO Connection String builder dialog: 
 

 
 
At any time while in this dialog, more detailed help can be obtained by clicking the Help button in 
the lower portion of the dialog or refer to your database's instructions on using an ADO 
connection.  If using the provided Microsoft Access table, this string should already be configured 
and ready to use, but you could change the location of this file or use a completely different file, if 
desired.  In general, choose the provider for the database you will use on the Provider tab.  Enter 
the location and login credentials for the database on the Connection tab. 
 
NOTE:  If you do not choose to save the password to the database connection, D2M will prompt 
the user for a password every time D2M is opened. 
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ALSO NOTE:  If the server type is not available in the ADO dialog, the ADO driver or database 
client may not be installed on that system.  Please install the driver or proper software for your 
database on each D2M client machine.  Please consult with your database vendor or 
documentation about client software and the use of an ADO provider. 
 
After the database connection is configured, test the connection by clicking the Test 
Connection button. 
 
Save changes at any time by clicking the Save button.   
 
Testing the Database Connection 
Click the Test Connection button to test the database connection.  This is the connection that 
will be used by the Docs2Manage program. 
 
If the connection is not successful, you will be prompted why the connection failed. 
 
NOTE: This function only test that the database connection is valid.  It does not test whether the 
D2M tables exist or that you have the proper rights to these tables.  
 
Setting Image Quality versus Image Size 
If you are storing your documents in B&W Tiff format, this setting has no effect.  B&W Tiff is the 
preferred image format for most document management needs where ink and paper color are 
unimportant. 
 
When Docs2Manage (D2M) stores images in the database as jpeg's, even at the highest quality, 
jpegs are much more compressed than Windows bitmaps.   
 
Change this setting to the lowest number where you find the quality acceptable.  In most cases, 
60% is enough, but this also depends on what you are trying to store.  For example, if you are 
storing important documents like x-rays and blueprints, you may want the quality level to be 
between 80 and 100%.  If you are storing old bills which only need to be readable, 50 to 70% 
maybe acceptable.   
 
Size may also become an issue if you plan to store a high number of documents.  For example, 
storing an 8 x 10 letter typically uses 200Kb at 100% quality.  This means 100Mb would store 500 
similar type documents.  At 50% quality, the document was 50Kb.  In this case, 100Mb would 
store 2,000 documents. 
 
NOTE:  If your scanner allows you to adjust the dots per inch (dpi), 96 through 200 dpi are 
recommended for most documents stored in jpeg format, 200 through 300 dpi is recommended 
for B&W Tiff.  Use a higher dpi if quality of the image is an issue.  Naturally, the higher the dpi, 
the more disk space the image will use. 
 
TIP:  To test how much disk space the image uses in the database, view the actual image size on 
the status bar at the bottom of the screen.   
 
Setting the Working Directory 
The working directory stores temporary images and/or Windows Documents that are transferred 
to and from Docs2Manage (D2M) and your Default Editor.  The default working directory is the 
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D2M installation directory.  You can change this to any other valid directory. 
 
NOTE:  When D2M is closed, D2M attempts to automatically delete any temporary files that were 
used, so you should not have to worry about cleaning up temporary files used by D2M.  
 
Preview Documents Stored as Files 
When documents are stored as a file, check this option to display a preview of the actual 
document in the preview area.  To create the preview, Docs2Manage will load this document into 
a special viewer, which does cause a bit of a delay that may be significant on older computers.  
Uncheck this option if you find this significantly slows down the operation of scrolling through 
pages or if you do not require a document preview.  
 
Include Icons on Page Grid 
When checked, this option shows an icon of the file or image type within the page grid and re-
sizes the rows to the best fit icons.  This also means each row in the page grid will be 2.5 times 
the row height then when the icons are not shown.  
 
Show Page Totals after Scanning 
When this option is checked, Docs2Manage will report how many pages were scanned and 
saved to the system after the scanning dialog or operation is closed or complete.  If you use 
Blank Page Detection, blank pages will add to the scanned count, but not add to the saved 
count.  
 
How to Add Non-image Type Files 
This setting controls how non-image type documents are stored in Docs2Manage (D2M).  There 
are three options to set as the default: 
 

•  Store File Zipped in Original File Format (highly recommended) - storing documents in 

the original file format is preferred, especially since the software used to create the document 
may change.  Most software offers backwards compatibility.  D2M now can even preview 
documents stored as files in the image preview area. 
•  Store File in as Windows OLE format - stored files are tied to the actual version of the 

actual software, so as you change versions of the software originally used to create the 
document, there is no guarantee that the document will open in the newer version of the software 
stored in this format. 
•  Ask How to Store File Later - asks the user to choose how store the file.  
 
Show Document Folder Path Info in Document Grid 
This option when activated, shows the folder path information from Document Explorer for each 
record in the document grid.  The choices are as follows: 
Show Entire Folder Path in Grid (can slow performance)- This option is useful while in grid 
view or you have selected to show all document under the selected folder.  This will give you the 
entire path to the folder location of the document.  This option can slow performance since 
Docs2Manage has to walk up the document folder hierarchy to get the entire path for each 
document in the document grid.  If this options slow performance too greatly, use the "Only Show 
Folder Name in Grid" option instead. 
Only Show Folder Name in Grid- This option only shows the folder name for each document in 
the document grid is in and does not include the entire path leading to that folder. 
Don't Show Any Folder Information in Grid- No information about folder location is shown in 
the document grid (the column will not be displayed).  
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Setting the Default Image Editor 
The Current Jpeg Editor setting requires that you have a valid image editor installed on your 
machine. 
 
Leave this field blank if you want the Windows default image editor installed on your machine to 
be used for editing your image-based documents.  If the Load / Edit Document in Outside 
Editor button on the Docs2Manage Document Pages form does not appear to load the image in 
your image editor, you may have to enter the location of the editor even though it is Windows 
default. 
 
If you have an image editor you want to use but it is not the windows default, you must set this 
field to the location of the image editor's application file (the ???.exe file). 
 
NOTE:  On machines without an image editor, Internet Explorer (iexplore.exe) or MS Paint will 
most likely be the default.   
 
Auto-narrowing Your Searches (Smart Searches) 
This feature makes searching more logical.  This is done by repopulating the search combo fields 
or search tree with values that only exist in the current results, as if the search was executed.  As 
you select search values, queries determine the values that are valid for the other fields you have 
not searched against yet, so you are only left with choices that will yield results to the search you 
may next attempt. 
 
Because this option runs several queries to determine what the eligible values for the other 
search fields are, there may be a delay as Docs2Manage runs these queries.  If your database is 
rather large and this delay becomes too long, this option should be turned off. 
 
NOTE: If database performance becomes slow in general, ask your database administrator if 
heavily searched fields are indexed.   
 
Setting the Default Search - Date Range 
This is the number of days of history or into the future that will be used for the default search.  
The default search is the default setting when Docs2Manage (D2M) is started or the search is 
reset.  This is to prevent long delays for large databases that may have a high number of 
documents throughout the history of the database. 
 
It may be useful to set this value lower if you received a warning from D2M that you exceeded the 
100,000-document record fetch limit.  This limit is imposed in order to minimize the amount of 
time and system memory required to open a high volume of documents.  This does not mean that 
these records are not in your database - you would need to adjust the date range search criteria 
to find the desired record(s). 
 
For example, if you set the Days of History setting to 90 days, this means when D2M opens, D2M 
will only request documents dated within the last 90 days.  If you want to retrieve documents 
before then, you will have to change the search to retrieve and find the desired record(s). 
 
If you plan to date document into the future than you will want to set the "Days into the Future" to 
cover these documents dated into the future.  
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Include File Names when Importing Files 
Check this option to copy the file name of the document into the Notes field of the Documents 
Page record.  This does not include file path information.  This can be very useful if you want to 
search for a document and know the actual file name you are looking for. 
 
Update Document Date when Importing Files 
Check this option if you want Docs2Manage to automatically update the D2M document date 
[[DATEOFDOC]] to the modified date of the actual file being imported.  
 
Scanning Options 

 
Scanning Options 
Scanned Image Type 
For all editions, you may choose Jpeg, Tiff in B&W or grayscale, and PNG in Grayscale, 256 
colors, and RGB color.  Depending on what image type you choose; D2M will try to tell the 
scanner to scan using that color level.  For more information about image formats, please read 
the Image Formats Supported by D2M section of this help file. 
 
Rotate on scan (Simplex Side) 
Many scanners, especially those equipped with an Automatic Document Feeder (ADF), return an 
image that is consistently rotated 90 or 180 degrees off.  This setting automatically rotates the 
image as it is being scanned to correct this. 
 
Despeckle on scan (B&W Tiff Only) 
This option helps clean up a document that is littered with "speckles" on a B&W document. 
•  1-pixel despeckle - means that D2M will change a lone black pixel to white if the surrounding 8 

pixels are all white. 
•  2-pixel despeckle - works just like 1-pixel despeckle, but still changes the black pixel to white 

even if 1 out of the 8 pixels are black (7 white). 
•  3-pixel despeckle - works just like 1-pixel despeckle, but still changes the black pixel to white 

even if 2 out of the 8 pixels are black (6 white). 
Keep in mind, despeckle will slow down the scanning process.  Before using this option, please 
set your scanner to the highest contrast and increase brightness when scanning in B&W mode.  
This will eliminate a lot of speckles without any cost of performance. 
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Deskew on scan (B&W Tiff Only) 
Some scanners with ADF sometime misfeed slightly and a document will be scanned at a slight 
angle.  This option will attempt to correct this condition by rotating the scanned image by a slight 
amount.  However, this option only tends to work on documents with pronounced lines or 
margins.  If the document does not have this, it may be rotated in varying degrees.  Therefore, 
this option is not recommended if you are scanning many different types of documents. 
 
Auto-crop on scan (B&W Tiff Only) 
This option will attempt to eliminate white space outside of the document area.  It may be very 
useful when scanning documents such as bank checks through a document feeder to eliminate 
the unneeded white space. 
 
WARNING:  Be careful using this option, as it may cut-off more than you desire if the document 
does not have well defined borders. 
 
Duplex Scanning Options 
Scanner Type 
•  Simplex scanners, the default, are all flatbed scanners without an ADF or scanners with an 

ADF, but only made or intended to scan one-side.   
•  The other two options indicate a duplex scanner and which side of the image is returned first 

when scanning both sides.  In either case, D2M will try to tell the scanner to scan in Simplex 
mode (even if a Duplex scanner) or in Duplex mode depending on this setting. 
 
Blank-page Detection (B&W Tiff Only) 
This will attempt to determine what percent of the page are black pixels.  If the scanned page 
percent of black pixels is less than the percentage indicated, then the page will be dropped 
without being processed and saved.  Please experiment with this setting by starting this number 
very low like at 0.05% and move up till the scan of a blank page is kept. Next, lower that number 
to the last number percent that last eliminated the scan. 
 
Rotate on scan (Duplex Side) 
This option works just like the Rotate on Scan (Simplex side) option but rotates only the Duplex 
Side of the scan.  In most cases, this option should be the set to the same rotation as the Simplex 
side. 
 
Printing Options 

 
 
General Options 
Always Show Select Printer 
This option when checked will cause Docs2Manage to pop-up the standard select printer dialog 
before printing. 
 
Print PDF Documents 
This option when checked will attempt to print out PDF documents that are stored in 
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Docs2Manage.  Keep in mind that this option uses a built-in PDF viewer, which may not print out 
as accurately as Adobe Acrobat.  If this option is unchecked, PDF files will be skipped by the 
printing process. 
 
Sizing of image to the printed page 
Resize and Rotate to best-fit paper 
This option ignores the Printer Orientation option and will attempt to fill a sheet of paper with the 
most proportional fit by automatically changing the printer orientation to use up the most area on 
a printed sheet of paper. 
 
Resize to fit width of paper only 
This option is the same as the prior option but uses the selected printer orientation to print 
proportionately to the printer's paper width.  This may be better than the prior option when you do 
not want any page rotated differently than the rest. 
 
Resize to fit width if image width is bigger than paper 
This is the best overall choice for general printing. This option does not stretch an image 
proportionately when an image is smaller than the page it is about to be printed on.  If this is the 
case, the document should print very close to its original size.  If the image is larger than the page 
width, it will proportionately be made smaller to fit the page width. 
 
Printer Orientation 
Portrait  
The paper's shorter length is considered the width.  This is the best option in most cases. 
 
Landscape 
The paper's longer length is considered the width.  This may be a good option if you tend to scan 
more documents with greater width than length, like in the cases of some invoices or bank 
checks. 
  
Installing the Docs2Manage Printer (TO BE DEPRECATED) 
This functionality is pending removal, as it will not work with Windows 7 or higher.  We are 
researching a replacement for a future version of D2M.  Attempting installations of the 
Docs2Manage Printer will fail if you try on Windows 7 or higher. 
 
Is the Docs2Manage Printer installed? 
When Docs2Manage (D2M) is installed, the D2M Printer should have also been installed.  Under 
the Control Panel, select "Printers" and look for the printer entry "D2M Printer". 
 

 
 
Re-installing the D2M Printer 
If the D2M Printer is not installed or was deleted, you can add the D2M Printer by loading the 
Config program and pressing the Install D2M Printer button located on the Additional 
Options tab.  You will be prompted if the printer installed successfully. 
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Sharing the D2M Printer on a Network (tested on MS Win 2000 network and higher) 
Once the printer is successfully installed, you may share the printer with the rest of the network.  
To share this printer, under the Control Panel, select "Printers" and look for the printer entry "D2M 
Printer".  Right-click that printer entry and select "sharing" from the pop-up menu.  Enter printer 
name. 
 
On the client workstations that will use this printer, select to install this printer from its network 
location and name.  This may require your operating system CD-ROM to complete the install.  
Once installed, printing to this printer will capture print jobs as long as the sharing computer has 
D2M in Printer Capture Mode. 
 
Docs2Manage Printer Image Capture Format (TO BE 
DEPRECATED) 
This functionality is pending removal, as it will not work with Windows 7 or higher.  We are 
researching a replacement for a future version of D2M. 
 

 
 
Similar to scanning documents, Docs2Manage (D2M) allows you to configure what image format 
in which the print jobs will be captured and saved.  This format can be different than the image 
format used to capture scanned documents.  Please refer to Image Formats Supported by 
D2M for an explanation of the image format that can be used to capture the D2M Printer print 
jobs. 
 
The D2M Printer only captures print jobs in black & white format regardless of what image format 
you use.  
 
Workflow Options 

 
 
Please refer to Workflow & Repository Tree View section for more information on the tree view 
(workflow view). 
 
Repository Refresh Rate 
This setting refreshes the data while in repository mode and in the tree view (workflow) mode.  
This does not refresh data in the repository while in the form view mode.  This feature is useful if 
many people are moving documents from one repository (folder) to another on the network.  This 
setting will re-query the database updating the number of pages in each repository along with the 
actual pages.  The more movement of documents by different users, the shorter the refresh time 
should be. 
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Open in Repository Mode 
This option will open Docs2Manage (D2M) in Repository mode, which is especially useful when 
D2M is being used in workflow mode.  
 
OCR Options 

 
 
OCR Plug-in Enabled 
Beginning in Docs2Manage version 4.x, the OCR engine is now included.  However, if you only 
want to extract keywords text-based documents (MS Word, Excel, etc.), and not from image-
based documents, you can uncheck this field.  However, this field should be checked if you want 
to OCR image-based documents. 
 
OCR Engine Mode 
Docs2Manage now includes multiple OCR engines.  The default is the LSTM Only Engine and 
the other is the Tesseract Only Engine. By default, the LSTM Only Engine using English 
Language data files are already installed. 
 
OCR Language Code(s) using Language Selector 
By default the data files for English Language are installed for the default OCR engine, which is 
the LSTM Only Engine.  You can select one or more languages, but you must install the files 
needed for additional languages.   To select a single language, make sure the "Store Multiple 
Languages" check-box is unchecked.  As you change the "Language Selector" drop-down, you 
should see the "Stored Language Code(s)" change.  Each language code is 3 letters.  If you want 
to use multiple languages, then check the "Store Multiple Languages" check-box.  As you change 
the "Language Selector" drop-down box, you will see additional languages populate in the 
"Stored Language Code(s)" field separated by the "+" symbol.  If you need to reset the "Stored 
Language Code(s)", unchecked the  "Store Multiple Languages" check-box and select one of 
your desired languages in the "Language Selector" and re-check the "Store Multiple Languages" 
check-box if you want to add additional languages after that. 
 
For additional information and language files for the LSTM/Tesseract OCR Engine(s), please visit 
their support pages: 
Product Wiki: Tesseract Wiki Page 
Language Files Support: Tesseract Data Files Page 
 

https://github.com/tesseract-ocr/tesseract/wiki
https://github.com/tesseract-ocr/tesseract/wiki
https://github.com/tesseract-ocr/tesseract/wiki/Data-Files
https://github.com/tesseract-ocr/tesseract/wiki/Data-Files
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DOCWORDS table KEYWORDS field length 
This option should not be changed from the default of 255.  This field is the expected length of the 
KEYWORDS field in the DOCWORDS table.  Many documents' OCR results will exceed the 
KEYWORDS field length.  In these cases, D2M needs to know the length of this field so it can 
split the OCR/Keywords results across several records.  D2M adds the results from the many 
records to have a complete set of keywords for a page or document. 
 
Only OCR New Documents for keywords 
Check this field if D2M should only OCR pages that have not been OCRed before. 
 
Minimum Character Confidence (default 20%) 
D2M will reject any character less than the confidence percent indicated. 
 
Acceptable Page Confidence (default 30%) 
D2M will reject any page with less than the confidence percent indicated.  This is computed by 
averaging all the character confidences together on that page. 
 
Preferred (default 60%) 
A page confidence above this percent is always considered a good OCR read.  If auto-rotate is 
checked, a page exceeding this confidence level is considered the correct orientation to OCR the 
page.  Further rotation is not necessary, saving time. 
 
Extract Keywords from PDF, MS Office Documents, Word Perfect, etc. 
Supported formats - .pdf, .doc, .rtf, .wpd, .wri, .txt, .xls, .eml, .msg, .htm, .html, .xml) 
When this option is checked, D2M will attempt to extract keywords from MS Word Documents 
when they are stored as a file (not as an OLE Windows Document).  These keywords will be 
stored the same way an OCRed image page is stored even if the MS Word Document is several 
pages.   
 
Auto-rotate until preferred page confidence is met 
When this option is checked, D2M will rotate the page and the four different read confidence 
levels will be analyzed to determine how the page should be rotated.  During this process, if the 
preferred page confidence is met, the proper rotation is considered found and testing stops to 
save time.  The OCR results from the best confidence rotation are stored as the keywords. 
 
Rotate Image-based PDF Documents to extract text 
Image-based PDF documents can consist of one or many pages of images.  Most of the time, 
these images are already oriented correctly (right-side up), which allows the OCR Engine to 
extract text easily.  However, if your PDF documents are not, checking this check-box will allow 
Docs2Manage to extract each image and rotate as needed.  However, if you have large PDF 
documents, this could cost a considerable amount of time to process, so only check this if 
necessary. 
 
Keywords to Exclude 
These are words D2M will eliminate that will not aid in searching later.  Words like "and", "or", 
"but", and "what" are too common to be considered useful.  You may add, remove, or edit words 
on this list.  There should only be one word per line in this box. 
 
NOTE:  Please test how these settings will work with the documents you add to the system, 
especially if you plan to use the auto-rotate feature. 
 
Language, Font, and Application Theme Options 
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Language, Character Set, and Font 
This section allows you to select a different language, character set, font, and size which you may 
have installed on your system for other languages.  This will change the character set and font for 
every control inside Docs2Manage (D2M) except the menus, which is controlled by Windows.   
 
NOTE: Please read the Internationalization and Language Support for more information about 
changing and using a different language in Docs2Manage. 
 
Theme 
Customize the look of the D2M user interface (windows, buttons, etc.) by using a theme.  You 
may select from one of the predefined options or add your own by adding the D2MTheme.skn file 
to the Docs2Manage installation directory.  The Configuration program user interface will 
immediately display the theme and the D2M user interface will use the theme the next time it is 
opened. 
 
The Set to D2M Default button returns D2M to its factory state.  Click this button if you changed 
to a font that causes the D2M interface to become unreadable.  
 
Saving Settings 
The Save button saves any changes since the Configuration program was loaded or since the 
Save button was last pressed.  These changes are saved into the system registry, where 
Docs2Manage (D2M) can access them as it opens. 
 
NOTE:  If D2M is currently running, D2M will need to be restarted for any changes to take effect.  
 
Undoing Changes 
The Undo button will cancel any changes since the Configuration program was loaded or since 
the save button was last pressed.   
 
Exiting the Configuration Program 
The Exit button exits the Configuration program.  If changes were made to the configuration, you 
will be prompted to save or cancel any changes.  
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Chapter 3 – Using Docs2Manage 
 
Docs2Manage Program Overview 
Before you use the main Docs2Manage (D2M) program, you may want to use the Configuration 
program to edit the settings or database connections this program will use. 
 
When you first load the main program, you may consider setting up the security layer D2M will 
implement using the options under the Security menu.  This will display or hide many of the 
controls and features in D2M for the various types of users you may have per your security 
needs.  Please read about this in the Security and D2M section of the help file. 
 
Create a Folder Structure 
When you first enter D2M, you will see the Document Explorer View where you will create a 
folder structure where documents may be placed and stored.  You must create at least one 
folder. 
 

 
 
To add a Folder: 
1. Click the New Folder button on the main tool bar. 
2. Customize the Folder name in the Document Explorer. 
3. Add additional folders by repeating steps 1-2. 
 
To add a Sub-Folder: 
1. Select the Folder to create a sub-folder under. 
2. Click the down arrow button next to the New Folder button on the main tool bar. 
3. Click New Sub-Folder from the drop-down list. 
4. Customize the Sub-Folder name in the Document Explorer. 
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5. Add additional sub-folders by repeating steps 1-4. 
 
Alternatively, you may right-click on the mouse instead of using the main tool bar to create and 
rename folders. 
 
Enter Document Information 
Once you have defined your folder structure, you are ready to add your first document.  First 
select the folder you want the document to appear in.  Next, either click the "Scan" button or 
"Import" button to import an existing file on the main toolbar.  This will open a dialog where you 
can enter the information about the document you are about to add.  Later, if you need to, you 
can edit this document information on this from again by clicking "Edit/View Document Info" under 
the "View" main menu or under the pop-up menu for the document grid or press [F11]. 
 

 
 
Add Pages to a Document 
After you have entered information about a document, click the "Scan Pages" or "Add Pages" 
button on the bottom of the form. 
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If scanning: 
1. The scanning interface will display. 
2.  Load the scanner with your document and press the scan button.   
3. The scanner interface will remain open to allow you to add many sets of pages.  Press cancel 
or close to close the scanning interface. 
4. The document should appear in the document grid unless you categorized the document in a 
different folder. 
 
NOTE: D2M assumes you do not need to see the document you just scanned.  If you do want to 
see what you just scanned, double-click the document record in the grid or press [F12] to display 
the Pages Form.  You can also do this if you need to add more pages to this document later. 
 
If importing: 
1. Click Import Document(s) from File button toward the bottom of the page. 
2. Select desired file(s) and click Open button.  The new pages will appear in the thumbnail or 
grid view of the form. 
3. To save time, you can also drag-and-drop files into D2M. 
4. Use the Document Image Data Navigator at the top of the form to navigate page-to-page, 
change the order of pages, or delete pages. 
5. Click OK button when you are finished. 
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Later, if you need to, you add or edit pages for a document by clicking "View/Modify Pages" under 
the "View" main menu or under the pop-up menu for the document grid or press [F12] to display 
the Pages Form. 
 
 
While in D2M, additional help is available by setting focus on the control or field you need help 
with and pressing the <F1> key. 
 
Docs2Manage Views 
Docs2Manage (D2M) has three different ways to view your folder structure and documents.  
These views can be changed by selecting the different views available under the "View" main 
menu. 
 
Document Explorer 
Work in this mode to easily view and modify the folder structure on the left side of the window.   
 

 
 
To switch to Document Explorer view, click Document Explorer under the View menu or press 
[F5]. 
 
While in this view, you can right-click the explorer area to display a pop-up menu of folder 
operations and viewing preferences.  Please read the Document Explorer section about this topic. 
 
Data Explorer 
This view is based on the data's Search Fields.  Records are displayed according to the Search 
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Fields of type "Drop-down Combo field" which you may have defined.  The Search Fields are pre-
populated on the Document Search Tree.  Use the Date Range and Keywords search fields on 
Document Search Tree to quickly narrow the tree search to those that fit the given criteria. 
 
The count of all documents before the tree search begins is next to the top node on the tree.  As 
you select items on the tree, the search adds more criteria until all your search options are used 
or there is only one document to preview. 
 
NOTE:  This feature works best with the auto-narrowing search option on.  Without this option on, 
the tree will show all values of a tree node, even when the selection of certain values will return 
no records.  When this option is on, only valid values will display in the tree nodes as you perform 
your tree view search. 
 

 
 
To switch to Data Explorer view, click Data Explorer under the View menu or press [F6]. 
 
Data Grid 
This view displays all documents in a single grid view.  Any defined folder structure is not 
displayed, and you cannot create or modify folders.  However, this view allows you to view search 
results that may span many document folders. 
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To switch to Data Grid view, click Data Grid under the View menu or press [F7]. 
 
Document Explorer 

 
This interface works very similar to Windows Explorer.  It allows you to create, delete, and 
rename folders with an unlimited number of folders and sub-folders.  This can be done by using 
the main toolbar or the pop-up menu (described below).  You can also drag-and-drop folders into 
other folders as needed.  To the right of this area is the list of documents in a grid that belong to 
that folder (and in some cases sub-folders as well). 
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This menu appears by right-clicking the document explorer area. 
 
New Folder 
This creates a folder at the same level of the selected folder.  Once the folder is created you may 
type in the name you want the folder to have. 
 
New Sub-Folder 
This creates a sub-folder under the level of the selected folder.  Once the folder is created you 
may type in the name you want the folder to have. 
 
Delete Folder 
Deletes the selected folder. 
 
Rename Folder 
Makes the text or name of the selected folder changeable. 
 
View Documents under this Folder 
This toggles between two document fetching modes.  When this mode is "on", all document in the 
selected folder and all the documents in the sub-folders of the selected folder are displayed.  This 
mode assumes as you navigate deeper into the sub-folders, less documents will appear on the 
right side in the document grid.  This would be good if you knew what area a document was in, 
but did not know what sub-folder it was in.  The document grid can configured to show the 
actual folder path of all the documents showing in the grid.  When this mode is "off" the only 
documents that show in the grid are those that belong to that specific folder.  This is exactly how 
Windows Explorer functions.  
 
Document Information Grid 
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The Document Information Grid displayed on the main form either displays on the entire form 
while in Data Grid view or just on the right side of the main form while in Document or Data 
Explorer views.  While in Document Explorer mode, documents from the grid can be drag-and-
dropped into other folders on the left.  If you double-click the grid or press [F12] the Pages 
Form will display the pages that belong to that document.  By pressing [F11] the 
detailed Document Information Form will display for viewing or editing.   By pressing [F10] the 
grid can be toggled between edit mode and selection mode.  This will be explained in more detail 
below.  By right-clicking the grid, all these options are available along with a few others which will 
be described below.  
 

 
(Document Grid in "Edit" Mode) 
 
By pressing [F10] or the "Edit Document Record Grid Mode" menu item under the "View" menu of 
the main menu or under the pop-up menu for the grid (shown below), the grid can have two 
purposes.   
 
When this option is "on" the information in the grid is changeable (assuming you have the right).  
This is convenient if you want to classify a group of documents brought in from a repository that 
were brought over to the classified area not completely classified (like the invoice number for 
these documents reads "later").  This allows you to navigate through documents and edit or 
classify them without having to open the Document Information Form.  In fact, you can leave the 
Pages form open while you are scrolling through and editing the document information.   
 
When this option is "off" the grid cannot be edited, but it does allow you to select records in the 
grid using the shift or control keys.  The purpose of selecting multiple records is so that while you 
are in Document Explorer view, you can drag-and-drop one or many documents from one folder 
to another, delete, print, OCR, or Email multiple documents. 
 
Note: In either mode while in Document Explorer view, a single document can still be drag-and-
dropped into another folder. 
 
Also Note: The information in the grid can be printed or exported at any time by clicking the Print 
or Export Document Info in Grid from the File menu or Main Toolbar. 
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This menu appears when you right-click the grid. 
 
Select (include) this page 
This option selects the current document in the grid. 
 
Select ALL 
This option selects all the documents in the grid. 
 
Select NONE 
This option resets the selection of documents in the grid. 
 
OCR Selected Documents 
This OCRs all pages inside the selected documents in the document grid.  If Auto-rotate is on, 
pages will be rotated as needed to find the best OCR results. 
 
Print Selected Documents 
This prints all pages inside the selected documents in the document grid.  
 
Print or Export Info in Grid 
This option generates a quick report of all the information in the grid.  This report can be printed 
or exported to file.  
 
Edit Document Record Grid Mode [F10] 
Toggles the grid between edit and multi-selection mode.  More details about this stated above. 
 
Edit/View Document Info [F11] 
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Displays the Document Information Form for viewing or editing. 
 
Show/Modify Pages [F12] 
Displays the Pages Form pages that belong to that document.  Additional pages can be added to 
an existing document using this form. 
 
Select Pages from Repository 
If you find it necessary to add pages to existing documents in bulk, you can scan or add 
document pages to the repository first, and then add some or all of those pages by selecting 
"Select Pages from Repository", select the pages in the dialog you desire that you want to add to 
the selected document, and click the "Add pages to Document" button. 
 
Rights, Roles, and Security Event Logging 
From the Security menu, select Rights, Roles, and Event Logging. 
 
Rights and Event Logging 
This area lists all of the available rights in Docs2Manage (D2M).  Rights are assigned to roles 
(see below Role Rights section below). 
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The Right Names cannot be modified, but the Description and Log Event Description can be 
modified.  The Log Event Description will be recorded in the Security Event Log and reports. 
 
The Update button commits any changes to the current record. 
 
Event Logging 
Check a right's Log this Event checkbox to log when any user in any of the security groups 
accesses this right.  Be sure to test the events you want to log and check if the description you 
have entered is acceptable in the description of the actual log.  You can view or print the event 
log by accessing the log in the View and Report Security Event Log form. 
 
Log Event Description 
In most cases, the log event description will be copied to the actual event log and will be printed 
in the Event Log Reports.  In some cases, the system will add additional information when 
necessary to further describe certain activities, but log description will always be included in the 
event log.  This description can be modified for your organization's specific purposes.   Several 
merge fields can be used in the log description text and will be filled in at the time of the specific 
event.  These merge fields are as follows with description in parenthesis: 
 
Security Specific Merge Fields: 
[[DOCGROUP_ID]]  (Value of security group ID when user caused event) 
[[GROUPNAME]]  (Security group name when user caused event) 
[[USER_ID]]  (Value of user ID that caused event) 
[[USERLOGINNAME]] (User Login Name from database that caused event) 
[[DBNUM]]  (The database number the user is using to access current database) 
[[DBNAME]]  (The database name the user is using to access current database) 
 
Information About the Document Merge Fields (DOCMAIN table fields): 
[[DOC_ID]] 
[[DATEENTERED]] 
[[DATEOFDOC]] 
[[DOCENTITY]] 
[[DOCFOLDER]] 
[[DOCTYPE]] 
[[DOCSOURCE]] 
[[IMPORTANCE]] 
[[DOCREF]] 
[[NOTES]] 
 
NOTE: These merge fields should only be used on rights that have something to do with a 
document.  For example, it would not make sense to record the value of the DOC_ID when a user 
decided to change the Docs2Manage Theme (CanSelectTheme).  Also, the rights CanScan, 
CanLoad, CanCreateWinDoc initiate the entry of a new document; when these rights are 
accessed the data fields are not yet known.  It would be better to use the data based merge fields 
on the CanInsertDocInfo and CanInsertPages right, since they record the values after the 
document or page is actually saved successfully. 
 
TIP: If you are not sure what data fields correspond to the fields you are using, you can view the 
mapping in the field manager.  You can also place the cursor on the field in question and click 
[F12] while in the Document Information form.  This will tell you the actual field name of the 
underlying data field, which you must use as the merge field name surrounded with double 
brackets. 
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Page Specific Merge Fields (DOCPIC table): 
[[DOCNUM]] 
[[DOCNAME]] 
[[SRCFILENAME]] 
[[DOCNOTES]] 
 
NOTE: Do not use page level data fields for document level operations like CanInsertDocInfo or 
CanEditDocInfo, since those operations have nothing to do with document pages.  
 
Other Helpful Merge Fields: 
[[MAININFO]] (Is the equivalent of "Group: [[GROUPNAME]]  Doc_ID: [[DOC_ID]]  Doc Num: 
[[DOCNUM]]") 
 
EXAMPLE: If you use the field IMPORTANCE to hold the value of an invoice number, and want 
to see when someone changes an image of a page in an outside editor and then post the 
changes to the database, you would want to log both the CanModifyImages and CanEditPages 
rights.  Under the log description for CanModifyImages you may want the description to be: 
User modified invoice number [[IMPORTANCE]] page [[DOCNUM]] 
And CanEditPages log description to be: 
Page record for invoice [[IMPORTANCE]] page [[DOCNUM]] changed. 
 
As a result, the event log would capture the event with a description easily understood for both 
events accessed. 
 
Roles 
This area lists all of the possible roles available in D2M.  Roles will have rights assigned to them 
(see below Role Rights section) and then a role is assigned to each user for each group they are 
a part of. 
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Click the Create Default Roles (as needed) button to create the following default roles with 
suggested rights if they do not already exist: 
 

•  System Security Administrator - inherent right of being able to access the security forms; 

add, change, or delete users, groups, and roles in any group 
•  Group Administrator - inherent right of being able to access the security forms; add, change, 

or delete users, groups, and roles for groups that it has that right 
•  Standard User Role - all rights except Administrator level rights 

•  Read-only Role - read-only access 
 
The default role rights can be modified on the Role Rights form, as explained in the section 
below.     
 
To add a new role: 
1. Click the New Role button. 
2. Enter the Role Name of and Description.  
3. Click the Update button. 
4. Add additional roles by repeating steps 1-3. 
5. Click the View Toggle button to return to the grid view of all roles. 
 
New roles do not have any rights assigned to them.  Add rights on the Role Rights form, as 
explained in the section below. 
 
Role Rights 
This area displays what rights belong to a role.  Roles will be assigned to a user in every group 
they are joined to.  The Joining Users to Group / Special Rights section covers which groups (or 
departments) a user can access and what role (rights) they have in those groups. 
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Select a Role from the drop-down list.  Any assigned rights will be displayed in the grid below. 
 
Add role rights by doing either of the following: 
•  Click any one of the Add ALL Role Rights, Add Read-Only Role Rights, or Add Standard 

Role Rights buttons.  
•  Click the New Role Right button to select a specific right from the remaining possible rights. 
 
Delete role rights by doing either of the following: 
•  Click the Delete ALL Role Rights! button. 

•  Select a specific right from the grid listing and click the Delete Role Right button. 
 
NOTE:  Regardless of what rights belong to a role, you can always override a specific user's 
rights by granting (or revoking) that user from the User Special Rights page tab.  Therefore, you 
do not have to create different roles for every possible user scenario. 
 
Groups, Document Storage, and Users 
From the Security menu, select Groups, Document Storage, and Users. 
 
Security Groups 
This area manages all the groups (or departments) you intend to use in Docs2Manage (D2M).  
Read the Joining Users to Group / Special Rights section to define which groups a user can 
access and what rights and role they have in those groups. 
 
The concept of groups are the foundation of security in D2M.  For example, departments in a 
corporate environment or locations of a nationwide organization.  Employees of one department 
may not have access or the same rights to records of another department.  Employees of 
different departments may work with differing types of documents and need to classify documents 
in a way that is meaningful to that area.  D2M has the flexibility to allow each group to operate 
independently of one another.  Each group will have their own document explorer and be able to 
customize fields to classify documents in their respective groups or departments, as if each group 
had their own database.   
 
Read the Security and D2M section for more information regarding how D2M integrates security. 
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To add a new group: 
1. Click the New Group button. 
2. Enter a Group Name, i.e., Accounts Payable, Payroll, Manufacturing, Engineering. 
3. Owner defaults with the user name of the person making the new group entry. 
4. Click the Update button. 
5. Add additional groups by repeating steps 1-4. 
6. Click the View Toggle button to return to the grid view of all groups. 
 
NOTE:  Users can only access or search one group's documents at a time (if the user has access 
to multiple groups) - multiple group selection is not allowed.  If your division between groups is 
fuzzy, it will be difficult to know which group to search for the desired documents.  Therefore, 
groups should be obvious.  For example, if you were trying to find a blue print, you would expect 
to search the Engineering group.  If someone created two groups in D2M, "Engineering 1st floor" 
and "Engineering 2nd floor," you may have difficulty identifying which group to search. 
 
WARNING: The different editions of Docs2Manage allow differing number of security groups.  
Please read what each edition of Docs2Manage will allow in the Available Editions of 
Docs2Manage section of this help file or find more details about this on the Docs2Manage 
Website. 

http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
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Document Storage 
Docs2Manage always had the ability to store your documents embedded into the database.  File 
based document storage has been added beginning with Docs2Manage 2.0.  To learn of the 
benefits of this, please read the Document and File Storage Support section in this help file. 
 
WARNING: Although it is possible to use a different storage type and location for each security 
group, it is highly recommended to keep the storage type and location the same for all groups.  If 
you elect to have different storage types or locations in a single database, you will not be able to 
view other repositories that have a different storage type or location even though you may have 
right to those repositories in other groups.  Also, avoid switching an existing repository from one 
group to another if they have different storage types or locations.  These conditions and warnings 
do not apply if you use the same storage type and location for all groups. 
 
Document Access for Docs2Manage Users 
Storage Type 
Stored in Database: This method of storage is the easiest to manage.  This is the best type of 
storage for a single user or for a network when document storage is mainly only smaller 
documents like for scanned documents.  This is not a good format when storing very large files, 
since databases are not optimized to store large blocks of binary data.  This storage type stores 
both classifying data and documents in the same database making it very easy to recover from a 
database back-up.  If you are currently using this format, you can always convert to use a file-
based format.  Please read the Loading All Pages from All Document for Special Processing / 
OCR Database section of this help file about the conversion process. 
 
Stored in File Server (already connected): This method is best when a network share is not an 
option.  This type of storage is very good for all types of files both large and small.  This simply 
points to a directory on your computer or that is already mapped on your computer.  This may be 
the best choice if you plan to store your documents on a UNIX/Linux file server and you have 
special software to authenticate and map the file server to be accessed by your local machine.  
This directory (along with the database or database back-up) should be regularly backed-up in its 
entirety to insure that the system can be completely restored in case of a storage media failure. 
 
Example formats in "Storage Server" field: 
C:\D2MDocs 
\\computername\docsdir (assuming the share is already connected) 
 
NOTE: Special care should be given to make sure that users do not interfere with the sub-
directories or files inside this structure or the documents may become inaccessible. 
 
Stored in File Share (connect to share): This is the most secure and very good for all types of files 
both large and small.  This assumes the documents will be stored on a file server, which can best 
handle a large volume of documents.  This method when used in conjunction with a user name 
and password that are different and is unknown to the desktop user makes this share hidden and 
inaccessible to the desktop user.  This share (along with the database or database back-up) 
should be regularly backed-up in its entirety to insure that the system can be completely restored 
in case of a storage media failure. 
 
Example formats in "Storage Server" field: 
\\computername\docsdir (not connected) 
\\computername\docsdir$ (not connected) 
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Stored in Dropbox Cloud Storage: This method might be the best for a multi-location organization 
or where employees may be working at remote locations.  Dropbox distributes all documents to 
all users locally, so access is fast, and changes are updated close to real-time.  However, there 
are two main drawbacks to cloud storage- cost and size.  The more document space you use 
(and on some cloud storage how often you access those files) you may accumulate cost and 
fees.  Also, if you plan to store 1TB of documents in your cloud storage, you will need 1TB of 
local disk space on every computer that accesses those documents. 
 
As an alternative, it might be better to install Dropbox on a file server, share that directory on your 
network, and use File Server Storage (already connected) or File Share Storage (connect to 
share).  In this case Dropbox will only store on one file server per location. 
 
Stored on FTP Server: This method of storage is best if the documents are stored in a remote 
location available through the Internet through an FTP server.  If the documents are to be stored 
locally or in the local network, the other two file options listed above are the better method.  
Docs2Manage will use the provided login information to connect to the FTP server and to add or 
modify the documents.  This also makes it possible to use another server type for document 
storage, since FTP servers have a common set of commands regardless of the operating system. 
 
Example formats in "Storage Server" field: 
234.56.23.122 (IP Address of valid FTP server) 
www.myftpserver.com (valid domain name of FTP Server) 
 
Storage Path (for file based storage) 
This refers to a sub-directory of the listed storage server or if Dropbox is being used then the path 
is relative to the Dropbox home directory.  This makes it possible to isolate your documents when 
the file server, share, or FTP server are being used for multiple purposes.  The path field does not 
require slashes. 
 
User Name and Password (for File Share and FTP Servers only) 
Fill in these fields to authenticate the connection.  This typically should be a user name and 
password combination that the desktop user does not know.  The file share and FTP server 
should have the security set up to only allow connections from a user name only Docs2Manage 
will use. 
 
Server Timeout (FTP Servers only) 
The amount of time in seconds that the FTP server will kill the connection of the inactive user.  If 
Docs2Manage determines that the FTP server has exceeded this time, Docs2Manage will 
attempt to re-establish the connection to the FTP server. 
 
Document Access for the Docs2Web Server 
Docs2Web can either use the same storage server as the Docs2Manage users or this section 
can be filled in with how Docs2Web will access the document directory.  This makes it possible 
for the documents to be local to the web server, but accessible through a file share or FTP server 
through Docs2Manage.  If your Docs2Web web server is secure from your network users, it is 
recommended that Docs2Web connect to the file server locally or to a mapped drive that is 
already connected and authenticated.  This is best since Docs2Web, which could be serving a 
high volume of documents to a high number of users, will not have to go through extra steps to 
connect to the stored documents. 
 
All Users 
This area stores all the possible users allowed to use D2M, whether they are joined to none, one, 
some or all groups.  Read the Joining Users to Group / Special Rights section to define what 
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groups a user can access and what rights and role they have in those groups. 
 
A user is directly mapped to its actual database login name.  For every user you create in D2M, 
you must also have a corresponding user in the database.  The user must also have the proper 
rights in the database to do all the tasks that have been assigned through the D2M security.  For 
example, a user with read-only type role rights in D2M will only need read-only type rights (the 
SELECT right) in the database.  However, if this user has at least one security group in D2M 
where they have create or edit rights, then the user must have those rights in the database 
(SELECT, INSERT, UPDATE, DELETE rights).  Please see your database administrator about 
adding users to the database with the proper rights. 
 

 
 
To add a new user to the system (all fields are required except for Notes): 
 
1. Click the New User button 
2. The D2M User Login Name field should match the user name on the database server. 
3. Enter a Web Password. 
NOTE:  This password will become the password to log into a Docs2Web website, which can be 
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purchased separately.  Even if you do not plan to use Docs2Web, fill in some value into this field 
since it cannot be left blank. 
4. Enter the First and Last Name.  This name is displayed when a user may have locked or 
unlocked a document. 
5. Select a Default Group.  This group is the default group when a user opens D2M. 
6. Click the Update button. 
7. Add additional users by repeating steps 1-6. 
8. Click the View Toggle button to return to the grid view of all groups.    
 
Joining Users to Group / Special Rights 
From the Security menu, select Join Users to Groups / Special Rights. 
 
Join User to Group 
Once you have created users, groups (or departments), and roles, the Join User to Group form 
is used to add users to groups.  By selecting the appropriate role, you can determine what a 
specific user can do inside a certain group.   
 
For more help and understanding how Docs2Manage (D2M) integrates security read the Security 
and D2M section. 
 

 
 
To join a specific user to a group: 
1. Select the desired group from the drop-down list.   
2.  Click the Add User to Group button. 
3. Select a User from the drop-down list. 
4. Click the Okay button.  The user will appear in the User-Group grid view. 
5.  Click on the Role in Group cell that corresponds with the User and select a Role from the 
drop-down list. 
6. Check the Has Web Access check-box if you want to grant access to this joined user to be 
able to view data and documents in Docs2Web (an optional product) for this security group. 
7.  Click the Update button.  
8. To join more users to a group, repeat steps 1-7. 
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Read the below section if you would like to override some of the role rights for a specific user. 
 
User Specific Rights 
To reduce the need for a large number of roles with different collections of rights, the User 
Specific Rights form is used to override role rights by either granting or revoking rights for a 
specific user and security group.  This may be most useful when you have users that almost have 
the same roles except for one or two rights that are different. 
 
For example, if you have a Standard User role that includes the ability to scan documents 
(CanScan), this form will allow you to remove that right from a particular user in a group even 
though the role allows it.  User specific rights ALWAYS override those rights in a role.  Likewise, if 
a role did not include the scan right, this can be added or granted to a specific user. 
 

 
 
To add (or revoke) a specific right for a user: 
1. Select the security group (department) from the drop-down list.   
2. Select the user from the drop-down list.   
3. Click the Modify User Right button.   
4. Select the specific Right from the drop-down list in the grid. 
5. Check a right's Granted checkbox to grant of the right (unchecked revokes the right). 
6. Click the Update button.  
7. To create more user specific rights, repeat steps 1-6.  
 
NOTE:  Regardless of what rights a user has within a group, the user specific rights will always 
override the role's rights, even if you edit the roles in the future.  
 
View and Report Security Event Log 
The events that you decided to log when configuring rights are displayed in the Security Event 
Log.  Results are viewed on the Results tab and may also be displayed or printed in a report 
format.  Two types of reports are available:  Chronological Event Log Report or Event Log by 
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Right Report. 
 

 
 
1. From the Security menu, select View / Print Security Event Log. 
2. Modify any desired filter options to the narrow results. 
3. Click the Search & Retrieve button. 
4. Results are displayed on the Results tab. 
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5. Click View/Print Report button to display results in a report format. 
6. Select the desired report format (Chronological Event Log Report or Event Log by Right 
Report). 
7. Click the View Report button (if there are no records on the Results form, no report will 
generate). 
8.  As an alternative to the pre-designed reports, you can also create your own report that can be 
Printed or Exported by clicking the Print / Export Log Data. 
 
NOTE:  You can modify the Comments column for any record, if desired.  All other fields on the 
Results form are read-only.  Click the Update button if any changes were made to the log record. 
 
Click the DELETE Log in View button to delete all the records currently displayed in the grid 
window.  You will be prompted to confirm if you want to delete the records - once you delete 
them, you cannot retrieve them again.  Be careful who you give the right to use this form.  
 
Main Toolbar 
This is the Docs2Manage (D2M) main toolbar.  Some of these buttons or drop-down options may 
not appear if the user does not have rights to these actions. 
 

 
From left to right, button definitions are as follows: 
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  Click the Create New Folder button to add folders to the folder 
structure in the Document Explorer view.  This button will not appear if you are in the Data 
Explorer or Data Grid Views.  Click the down arrow next to the button to select from other folder 
options:  New Sub-Folder, Delete Folder, or Rename Folder. 
 

  Click the Scan New Document button to scan a document.   
 

  Click the New Document from Template button to create a new document from a 
template. 
 

  Click the Import from Files button to create a document based on a file or set of files. 
 

 Click the Copy Document Info to create a new document based on the current document.  
This copies the current document information to a new one but does not copy the pages.  The 
information can be changed and then the pages form will appear allowing the scanning or 
importing of documents or files. 
 

  This button switches the lock status.  Once a document is locked, it can only be edited by 
the locker.  Please read more about this in the Document Locking section. 
 

  Click the Delete Document button to delete the current 
document.  Activate the drop-down to delete either the selected (highlighted) documents or to 
delete all documents in the grid view. 
 
NOTE: If the document you are trying to delete does not have any pages, it will be deleted 
without any confirmation.  Likewise, if it does contain pages, you will be prompted to continue or 
cancel the delete operation.  Multi-document deletes will always ask for confirmation regardless if 
the documents have pages or not. 
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 Click the OCR Document button to OCR or extract the text from the current document.  
Activate the drop-down to OCR either the selected (highlighted) documents or to OCR all 
documents in the grid view. 
 
 

 Click the Email Document button to Email the current document.  If the document is a 
scanned document, Docs2Manage will convert it into a PDF document before attaching to an 
Email message.  Other file types will be attached in their original format.  This feature assumes 
that you have a MAPI compliant mail program like MS Outlook, MS Outlook Express, or Eudora.  
This feature will not work with web-based Email solutions.  Activate the drop-down to Email either 
the selected (highlighted) documents or to OCR all documents in the grid view.  Each document 
selected will create a separate attachment in your Email message. 
 
 

 Click the Print Document button to print the current document.  Activate the drop-down 
to print either the selected (highlighted) documents or to OCR all documents in the grid view.  
This feature will only print scanned documents, native image formats, and PDF documents (if 
the print PDF option is activated).  Documents of other formats can only be printed be opening 
them and printing them with the program made to view or edit them. 
 

 Click the Print or Export Info in Grid button to preview a report about the documents 
currently in view in the document grid.  This can then either be printed or exported to a file. 
 

 Click the Back-up/Move Documents to a Distribution CD/DVD button to invoke the 
back-up dialog.  More help about this feature can be found in the Backing-up the Database / Build 
a CD-ROM Archive Dialog section.  
 

  This button invokes the Search dialog to start a document search.  For more help on 
finding records, please read the Searching and Filtering Records section. 
 
Selecting a Database 
You may change database connections you created in the Docs2Manage (D2M) Configuration 
program.  Please read the Database Connections section about creating and modifying database 
connections. 
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1. From the File menu, select Change Database. 
2. Select a database name. 
3. Click the Change Database button. 
 
NOTE:  The trial of D2M allows the first two database connections.  The Enterprise Edition allows 
an unlimited number of named connections, while the other editions only allow a single database 
connection.  Please read what each edition of Docs2Manage will allow in the Available Editions of 
Docs2Manage section of this help file or find more details about this on the Docs2Manage 
Website. 
 
Selecting a Security Group 
A user may switch between any security groups (or departments) to which that user belongs.  
The group is the core concept of security in Docs2Manage (D2M).  Please read more about 
security in the Security and D2M section. 
 
D2M allows each group to have its own document explorer folder structure and its own 
customized fields, essentially acting like each group is a completely different and independent 
database.  Users can have different rights in different groups. 
 

 
 
A user must be joined to more than one group for this drop-down combo box to appear (under the 
main toolbar buttons).  Please read Joining Users to Group / Special Rights for information on 
how to join users to groups. 
 
NOTE: The different editions of Docs2Manage allow differing numbers of security groups.  Please 
read what each edition of Docs2Manage will allow in the Available Editions of 
Docs2Manage section of this help file or find more details about this on the Docs2Manage 
Website. 
 
Searching and Filtering Records 
Customize a search using the Docs2Manage (D2M) filters to narrow your search results.  Once 
you are finished with the results, Reset the search so that you can see all records in the default 
date range, if desired. 
 

http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/
http://www.docs2manage.com/


 89  

 
 
1. Click the Search button on the main toolbar.  The view automatically switches to the Data Grid 
view. 
2. In the Search for Documents form, choose the criteria you want use as the search to find 
your desired record(s). 
3. Click the Search Button. 
4. Results are displayed in the Data Grid. 
5. Click the Reset button once you have finished with the result set. 
 
Advanced Search 
The Advanced Search works in conjunction with the main filter, i.e., the Advanced Search filters 
on the existing search results.  Advanced Search allows you to filter on any field from the main 
document table, including fields you may have added.  You can also filter on several fields at the 
same time using the Advanced filter. 
 

 
 
NOTE:  The main document table has been limited to fetch no more than 100,000 records at one 
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time in order to minimize the amount of time and system memory that D2M uses to fetch records.  
Therefore, you should attempt to organize your categories and date your documents so that a 
search using standard search fields will never exceed 100,000 records.  Since the Advanced 
Search only filters on what is already fetched, use the standard search fields first and narrow 
your search using the Advanced Search. 
 
Entering General Information about a Document 
From the View menu, select Edit/View Document Info or press [F11].   This form also appears 
automatically when you Scan, Import, or Copy a document. 
 
Enter general information about the document using the Document Information form.  You may 
display up to six classifying fields which you customize in the Field Manager.  These are also all 
the fields that can be searched by using the Search button located on the main toolbar.  If you 
need more than the six classifying fields, please read the Adding and Using Additional User 
Fields section.   
 

 
 
The field values may be populated by either selecting an existing value from the drop-down edit 
box or typing a new value into the drop-down edit box.  Answer Yes when prompted to add the 
new value to the drop-down field codes.  Alternatively, add new values in the Field Manager. 
 
Tree Folder Drop-down 
While in Document Explorer view, before you Scan, Import, or Copy a document, it is best to 
select the folder you want the document to belong to in the Document Tree on the left before you 
begin.  This will assign the Tree Folder field on the Document Information form without having to 
invoke the Tree Folder drop-down field in this form.  If you are in the Data Explorer View, Data 
Grid View, or if you desire to assign or change what Tree Folder (Document Explorer) a 
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document belongs to, you can invoke the Document Tree drop-down which will show the 
Document Explorer Tree in the drop-down.  To select the folder you desire, double-click the folder 
you want, which will assign and close the drop-down. 
 
Use the Notes field to enter any information or keywords that cannot be described in any of the 
other fields.  Text in this field is searchable by keyword using the Search button located on the 
main toolbar.  
 
 
Loading All Pages from All Document for Special Processing / 
OCR Database 
This feature force loads all pages from all documents and repositories simultaneously into a 
special page grid view.  This mode could be useful for extracting keywords via the OCR plug-in, 
special image processing, converting color Jpeg images to B&W Tiff (if you are upgrading from 
the old Standard Version, which had an image type restriction), or to change the document 
storage type within an entire group or database.  Docs2Manage (D2M) can extract keywords from 
scanned documents, MS Office Documents, and many other common file formats. 
 
While in this mode, you cannot add new documents or pages, since the concept of documents is 
currently disabled.   
 
If you switch into this mode while in Repository Mode, you can multi-select specific pages on 
which you want to do further processing. 
 
To load all pages from all documents: 
1. From the File menu, select Advanced Options > Load All Document Pages / OCR 
Database. 
2. Click Yes button to confirm you want to load all pages. 
3. Click Yes or No button to confirm whether want to load all pages from all security groups 
(applies only if user is a System Security Administrator) 
4. Click OK button to confirm the instructional message. 
5. Anywhere on the grid area, right-click the mouse and select OCR All Pages. 
 
NOTE:  Because this feature loads ALL pages from ALL documents, harm can occur with a few 
wrong moves.  Please be sure to back-up the database AND documents folder before doing 
anything that may modify the images of all the pages loaded in one operation (like rotate, 
despeckle, deskew, invert, auto-crop, and convert images to B&W Tiff), but this should not be 
necessary for extracting keywords via the OCR plug-in. 
 
6. Click OK button to confirm the status message. 
7. Right-click the page grid to display the Page Pop-up Menu that you may do on ALL pages from 
ALL documents as displayed below (active menu options only): 
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In addition to the  Page Pop-up Menu there are a couple other functions: 
 
Find Next Blank Page (B&W Tiff only) 
This option finds the next suspected blank page and takes you to the page so that you can verify 
if it is blank and delete it. 
 
Re-save ALL (Selected) Pages to New Storage Medium 
This option allows you to re-save your documents which are currently stored embedded in the 
database to files in a file directory.  This helps free up a great amount of space in the database.  
The benefits of this change are mentioned in the Document and File Storage Support section of 
this help file.  Before you can convert your database, you must define where the new documents 
will be stored.  This is discussed in the Document Storage section of this help file. 
 
NOTE: This re-save page feature can only work one security group at a time, since each group 
can have a different storage type and location.  When you are entering the "Load ALL pages from 
ALL documents" mode, click "No" to loading all the documents from all groups.   
 
Export ALL (Selected) Pages to Files 
This option allows you to save some or all your documents to files outside the system.  This may 
be useful if you want to back-up files in the database if they are embedded in the database or if 
you desire to use those files in another document management system.  These document pages 
are store is the format of Document ID followed by an underscore followed by the page number.  
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For example, 000000009_00003.tif refers to a document with the ID of 9 and page number 3 in 
TIFF format.  
 
Keywords Form 

 
 
This form shows all the keywords generated by the OCR process.  If you used the OCR keyword 
search option on the search screen, words that match results on the Keywords form will be 
highlighted in bold red. 
 
The text on this form can also be modified.  If you don't desire to use the OCR Plug-in, you can 
use this form to enter your own keywords for each page of a document.  
 
Adding and Using Additional User Fields 
The Document Information form will be populated with Additional User Fields if you added 
additional fields to the end of the DOCMAIN table. 
 

 
 
Add fields to the Main Document Info (DOCMAIN table) or Document Image detail (DOCPIC 
table) tables 
Included MS Access database:  A copy of Microsoft Access version 97 or higher must be 
installed.  In Access, find the D2Mdb.mdb or Access database that holds the Docs2Manage 
(D2M) tables that are referred to by this program.  Using the table designer, add new fields to 
either of the tables as needed.   
 
Enterprise databases:  To add fields to a SQL database, consult with your database's 
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documentation.  You might look for the "ALTER TABLE" command for proper syntax for adding 
fields to your database tables. 
 
All editions:  New fields added to the DOCMAIN table will be automatically added to 
the Additional User Fields section of the Document Info tab screen.  If you choose the data type 
to be date, then D2M will automatically use a calendar edit, all other field types will be plain text 
edits.  If you would like to define a field to use drop-down edits or change the displayed field 
name, then you should enter a field code record about a data column.  
 
NOTE: If you plan to create documents from document templates, you must also add any fields 
you added to the DOCMAIN table to the DOCTEMPLATE table.  These fields MUST have the 
same name and be the same field type as they are in the DOCMAIN table.  This will allow you to 
set default values for additional fields when a document template is used to create a new 
document. 
 
TIP:  When adding new fields in the database, you may want to only use UPPERCASE field 
names, limit the length of field names, and avoid using characters like spaces or dashes.  This is 
a good practice if you plan to migrate to an enterprise database (like Oracle) since the field 
names would not have to be changed to be acceptable in that database.  Also, data field 
information records would not need to be updated to match the field names that had to be 
changed. 
 
Similar to the standard D2M classifying fields, the additional fields can be customized on the Field 
Manager form. 
 
Example:  add a field with a fixed number of choices like in a drop-down edit box. 
 
1. In the database, add a text data field that allows as many characters necessary as the greatest 
length value (e.g., varchar(50) or text(50)). 
2. Click the Map New button and select your field from the drop-down list. 
3. Select Drop-down Edit from the Type of Field 
4. Enter a friendly caption  
5. Enter any known field values in the grid on the right side of the form. 
 
The field is now a drop-down edit field in D2M.  You can edit the displayed field name and default 
value on new record.  After you have entered at least one record that defines your field as a 
combo-box, you can add new values to your combo-box by typing in a new value into the actual 
field and answering Yes to adding the new value. 
 
Search on any of the additional fields by using the Advanced (Search) button. 
 
Document Image Data Navigator 
This is the Data Navigator for the Documents Pages form. 
 

 
From left to right, button definitions are as follows: 
 

  Quickly advance to a user specified page. 
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  Go to first page 
 

  Go back one page 
 

  Go forward one page 
 

  Go to last page 
 

  Move the selected page up (in order) 
 

  Move the selected page down (in order) 
 

  Delete the selected current page 
 

  Save pending changes to the page 
 

  Cancels pending changes to the page 
 
Adding Pages to a Document / Pages Form 
From the View menu, select View/Modify Pages or press [F12]. 
 
If you "Import" documents or files, this form should appear automatically after you have entered 
information about a document.  If you "Scan" a document from the Main Toolbar, this form is 
bypassed to go to the scanning interface.  In either event, you can also add pages to the 
document by either scanning or importing on the Documents Pages form later. 
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NOTE:  The Thumbnail View is the default display for pages of a document.  Right-click on the 
thumbnail part of the screen and select Grid View, if desired. 
 
NOTE ON DISPLAY:  When in Grid View, if you resize the column's width or position of the 
grid's columns, the changes will be saved for the next time the program is loaded. 
 
While in this form you have a couple ways to add pages: 
 
Scanning: 
1. Click Scan Image or Document button toward the bottom of the page. 
2. Follow directions to scan the document.  The new page appears in the thumbnail view of the 
form. 
3. Use the Document Image Data Navigator at the top of the form to navigate page-to-page, 
change the order of pages, or delete pages. 
 
Importing from files: 
1. Click Import Document(s) from File button toward the bottom of the page. 
2. Select desired documents or files and click Open button.  The new page(s) appears in the 
thumbnail view of the form. 
3. Add additional pages by repeating steps 1 and 2 if need be 
4. Use the Document Image Data Navigator at the top of the form to navigate page-to-page, 
change the order of pages, or delete pages. 
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NOTE: There is a faster alternative to importing files as stated above.  You can simply drag-and-
drop files from Windows Explorer into this form.  They will be imported automatically. 
 
Buttons to Add or Modify Documents and Images 
This is the collection of buttons to work with documents and images on the bottom of 
the Document Pages form. 
 

 
From left to right, button definitions are as follows: 
 

  Click the Load / Edit Document in Outside Editor button to view or modify a 
page using an outside editor.  Save any changes you made in the outside editor.  Normally, 
Docs2Manage (D2M) detects any changes to a document and automatically loads the document 
back into D2M.  If D2M is unable to detect a change (i.e., there is no change in the image view), 
click on the down arrow next to the button and select Merge in order to force D2M to load the 
changed document back into D2M. 
 

  Click the Import Document(s) from File button to load images and/or documents from 
any type of saved files.   Add multiple files at one time by holding the <Ctrl> or <Shift> key and 
selecting multiple files with your mouse.  Click on the down arrow next to the button to insert a 
Windows OLE object. 
 
NOTE: If you load a bitmap into a document image record in D2M, the bitmap will automatically 
be converted to a compressed jpeg before it is stored in the system.  
 

  Click the Save to File button to save the current page as a file.  Images can be saved as 
a jpeg, bitmap, tiff or png image format.  All other file formats should be saved with its original file 
extension.  If you elect to save an image page to a PDF, D2M will ask you if you desire all image 
pages to be a part of the PDF.  This gives you the ability to save multiple pages into one 
document. 
 
NOTE: If you need to save a Windows Document (OLE Document) to disk, try first saving the 
document in the editor the document loads in.  If this option is not available in the editor, then try 
saving it using the save feature. 
 

  Click the E-mail as PDF button to save and e-mail the current page.  Images will be saved 
as an Adobe Acrobat file (.pdf) (you will be asked if you want to create a PDF document for all 
image pages or just the current page in the document).  All other files will be stored in its original 
format.  D2M will then open the default MAPI compatible E-mail client, create a new E-mail 
message, and attach the document(s). 
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  Click the Select Scanner (Twain) Source button to select a scanner.  Choose the device 
(scanner or digital camera) from which you plan to acquire your images from the list of all 
installed twain sources and click the Select button. 
 
NOTE: Some scanners provide multiple Twain drivers.  Be sure to test the different twain drivers 
to determine which driver is best to use. 
 

  Click the Image Format button to select a default format that is used to store the 
images that are scanned. 
 

  Click the Scan Image or Document button to activate the twain device you previously 
selected.  Follow the device's user interface to scan or extract images from the device.  
 
Entering Specific Information about a Page 
When viewing the Document Pages form, you may select to display the pages using the Grid 
View (instead of the default Thumbnail view) by right-clicking the thumbnails and selecting Grid 
View. 
 
To insert a new document or image record on the page: 
1. Click on the Import Document or File or Scan button. 
2. Select the desired file or scan the document.  A new entry(s) will appear in the grid. 
3. Enter any information about the image document into the grid.  This information is also used 
when you perform a keyword search on the Search Dialog. 
•  The Ref Name and Notes fields allow you to enter extended text about the document. 

•  There is an auto-incrementing unique Page Number field. 

•  The read-only Source/Type, Document Description and Document Icon fields contain 

information about the content of the document, which D2M needs to load the document in the 
future. 
 
To add more classification fields that would be displayed on the grid, read the Adding and Using 
Additional User Fields section.  To customize the display names of existing fields, read 
the Entering Information about Data Fields section. 
 
By default, the grid is sorted by the Page Number column.  You may change the sorting of 
records by clicking on the grid column labels.   
 
There is no limit to the number of pages you can add to one document.  However, adding many 
pages against one document may make it hard to find a specific page.  A better practice is to 
have many documents with fewer page records, as document information records are more 
searchable.  
 
Pages Pop-up Menu 
On the Documents Page form, right-click on the Thumbnail View (or Grid View) area to display 
the pop-up menu. 
 
This Pages Pop-up Menu changes slightly when in Repository Mode. 
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In menu order, menu item definitions are as follows: 
 
Grid View 
Displays document pages in a grid format on the top half of the form. 
 
Thumbnail View 
Displays document pages using thumbnails on the left side of the form. 
 
Thumbnail Size 
Select from three sizes: small, medium, large.  
 
Move this Page to the Default Repository 
This choice moves the current page to the default repository.  This is necessary if you want to 
move a page to a different document.  Once the page is in the repository, move the page, along 
with other pages already in the repository to a new document.  Please read more 
about Repository Set-up and Mode.  
 
Move ALL Pages to the Default Repository 
This choice is just like the previous menu option, but it moves ALL pages to the default 
repository.  This might be used when you are trying to combine two documents into one.  Move 
one or more pages into a repository, then, in Repository Mode, select and move them to a new 
document. 
 
Select Pages from Repository 
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If you find it necessary to add pages to existing documents in bulk, you can scan or add 
document pages to the repository first, and then add some or all of those pages by selecting 
"Select Pages from Repository", select the pages in the dialog you desire to add to the existing 
document, and click the "Add pages to Document" button. 
 
Print All Pages 
This prints all pages in the current document (right-click the image itself to see a menu option to 
print a single page). 
 
OCR All Pages 
This OCRs all pages that belong to the current document.  If Auto-rotate is on, pages will be 
rotated as needed to find the best OCR results. 
 
Rotate All Pages 
This allows you to rotate all pages in the current document at one time.  Rotate pages right, left, 
or upside-down (right-click the image itself to see a menu option to rotate a single page). 
 
Despeckle All Pages (B&W Tiff only) 
This allows you to despeckle all pages in the current document at one time.  You have a choice of 
1, 2, or 3 pixel despeckle, which is explained more in the Scanning Options section (right-click the 
image itself to see a menu option to despeckle a single page). 
 
Deskew All Pages (B&W Tiff only) 
This allows you to deskew all pages in the current document at one time.  Deskewing attempts to 
straighten all pages that are at a slight angle. 
 
WARNING: This option may have undesirable effects on images when it cannot determine how to 
straighten them because of a lack of lines or margins.  Therefore, it is recommended you do this 
one image at a time, where you can still cancel if the deskew fails to work properly.  Right-click 
the image itself to see a menu option to deskew a single page. 
 
Invert All Pages (B&W Tiff only) 
This option inverts black and white, so black becomes white and white becomes black.  This is 
necessary for documents that are dark color or black background and have light color or white 
lettering.  Some scanners can sometimes return a normal document inverted in some cases, and 
this option allows you to invert it back without having to rescan it. 
 
Auto-Crop All Pages (B&W Tiff only) 
This attempts to determine where the edge of a document image is and eliminates the white 
space outside that region for all pages in the current document.  This option may be very useful 
when images like bank checks are scanned and you want to eliminate the unneeded white space 
for all pages in the document. 
 
WARNING: Be careful using this option, as it may cut-off more than you desire if the page does 
not have well defined borders.  Please test this feature on sample documents first before trying it 
on multiple documents. 
 
Convert All Images to B&W Tiff 
This option is for users who may elect to convert images from Jpeg or PNG to the much more 
efficient B&W Tiff format.  This is ideal if you have upgraded from the old Standard Edition, which 
did not support any image formats beyond Jpeg.  You can convert all documents in the entire 
database by using the Load All Document Pages feature under the Advanced Options in the 
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File menu.  This feature should be tested to assure the desired results.  You may want to back-up 
your database and files before using this feature on all document pages. 
 
Find Next Blank Page (B&W Tiff only) 
This option finds the next suspected blank page and takes you to the page so that you can verify 
if it is blank and possibly delete it. 
 
Delete ALL Pages 
Deletes ALL pages that belong to the current document (to delete a single page, press the delete 
button on the Document Image Data Navigator). 
 
Help 
This help section is displayed. 
 
Repository Pages Pop-up Menu 
On the Documents Page form, right-click on the Thumbnail View (or Grid View) area to display 
the pop-up menu. 
 
This Pages Pop-up Menu changes slightly when you are not in Repository Mode. 
 

 
In menu order, menu item definitions are as follows: 
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Grid View 
Displays document pages in a grid format on the top-right of the form. 
 
Thumbnail View 
Displays document pages using thumbnails on the top-right of the form. 
 
Thumbnail Size 
Select from three sizes: small, medium, large. 
 
Select (include) this page 
This highlights the current record so that some action can be performed on it at a later time.  
Actions include Printing, Rotating, Despeckling, Deskewing, and Deleting selected pages.  
 
Select ALL 
This highlights ALL page records so any of the actions can be performed on all of the pages in 
that repository. 
 
NOTE:  As with many Windows programs, you may also use the <Ctrl> or <Shift> key with the 
left mouse button to select a single or range of pages. 
 
Select None 
This cancels the selection from any or all page records. 
 
Move Selected to New Document 
This choice moves selected (highlighted) pages to a brand new document.  The Document 
Information form will pop-up and the information are copied to the new record.  Be sure to also 
indicate which folder you want the document to be in.  Select the folder from the "Destination 
Folder" field.  In the drop-down, double-click the folder you want the document to be in and close 
the drop-down. 
 
Move Selected to Individual New Documents 
This choice moves each selected page to its own new document.  The Document Information 
form will pop-up and the information are copied to the new documents.  It is recommended that 
you leave one of the fields with the value "later" or some other value that you can recall later.  
Later, when you are done with Repository Mode, you can search for the "later" value for that field 
to find those documents you moved earlier.  This way, you can update information about these 
records in more detail in the future. 
 
NOTE: Once pages are moved to a new record, they will no longer exist in the repository. 
 
Print Selected Pages 
This prints selected pages in a repository (right-click the image itself to see a menu option to print 
a single page). 
 
OCR Selected Pages 
This OCRs the selected pages that belong to the current document.  If Auto-rotate is on, pages 
will be rotated as needed to find the best OCR results. 
 
Rotate Selected Pages 
This allows you to rotate the selected pages in a repository.  Rotate pages right, left, or upside-
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down (right-click the image itself to see a menu option to rotate a single page). 
 
Despeckle Selected Pages (B&W Tiff only) 
This allows you to despeckle the selected pages in a repository.  You have a choice of 1, 2, or 3 
pixel despeckle, which is explained more in the Scanning Options section (right-click the image 
itself to see a menu option to despeckle a single page). 
 
Deskew Selected Pages (B&W Tiff only) 
This allows you to deskew the selected pages in a repository.  Deskewing attempts to straighten 
all pages that are at a slight angle. 
 
WARNING: This option may have undesirable effects on images when it cannot determine how to 
straighten them because of a lack of lines or margins.  Therefore, it is recommended you do this 
one image at a time, where you can still cancel if the deskew fails to work properly.  Right-click 
the image itself to see a menu option to deskew a single page. 
 
Auto-Crop Selected Pages (B&W Tiff only) 
This attempts to determine where the edge of a document image is and eliminates the white 
space outside that region for the selected pages in the document.  This option may be very useful 
when images like bank checks are scanned and you want to eliminate the unneeded white space 
for all pages in the document. 
 
WARNING: Be careful using this option, as it may cut-off more than you desire if the page does 
not have well defined borders.  Please test this feature on sample documents first before trying it 
on multiple documents. 
 
Convert Selected Images to B&W Tiff 
This option is for users who may elect to convert images from Jpeg or PNG to the much more 
efficient B&W Tiff format.  This is ideal if you have upgraded from the old Standard version, which 
did not support any image formats beyond Jpeg.  You can convert all documents in the entire 
database by using the Load All Document Pages feature under the Advanced Options in the 
File menu.  This feature should be tested to assure the desired results.  You may want to back-up 
your database before using this feature on all document pages. 
 
Find Next Blank Page (B&W Tiff only) 
This option finds the next suspected blank page and takes you to the page so that you can verify 
if it is blank and possibly delete it. 
 
Delete SELECTED Pages 
Deletes selected pages in the repository (to delete a single page, press the delete button on 
the Document Image Data Navigator). 
 
Help 
This help section is displayed. 
 
Page Image Preview 
When viewing the Document Pages form using the default Thumbnail View, the right side of the 
form displays the Page Image Preview  (if Grid View, preview is on the bottom half of the 
screen). 
 
This area offers a large preview of the document than the thumbnails and is usually sufficient to 
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be able to read and identify the page in view. 
 
NOTE:  In some cases, Windows documents may not have any OLE preview and as a result, the 
Page Image Preview area will be blank or the Windows document will fail to load on another 
user's machine because they may not have the proper software or an incompatible version.  To 
avoid this problem, you should select to store the file in its original file format in the Configuration 
program. 
 
Other Viewing Options:  Right-click anywhere on the Page Image Preview area to display a 
pop-up menu, which will allow you to switch the image preview size and options to manipulate the 
image. Please read Image Preview Manipulation Menu about this pop-up menu. 
 
Full Screen Image View:  Double-click anywhere on the Page Image Preview area for a full-
screen preview.  From there, you can also right-click to change the image display settings or 
switch into Annotations Mode.  Double-click or hit <Esc> to exit the full screen view.  
 
Page Image Preview Pop-up Menu 
On the Documents Page form, right-click on the Page Image Preview area to display the pop-up 
menu. 
 

 
In menu order, menu item definitions are as follows: 
 
Print Page 
This prints the current page in Page Image Preview (right-click the Thumbnail (or Grid) View area 
to see a menu option to print multiple pages). 
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Annotations Printing On 
This option when checked tells D2M to include any Annotations when printing pages. 
 
Proportional 
This displays the entire image in Page Image Preview.  This may make the page hard to read. 
 
Fit Width 
This fits the width of the image in Page Image Preview.  You may have to use the vertical scroll 
bar to see the bottom of the page. 
 
Normal 
This displays the image as-is in Page Image Preview.  If the image size is large, you may only be 
able to see a small section of the page at one time. 
 
Hide Image 
This does not display the image in Page Image Preview (instead, text regarding "Hide mode" is 
displayed).  This is useful when the stored images are very large.  This allows you to scroll 
through each page without loading each page, one by one.  Once you find the page you want to 
see, choose Proportional, Fit Width, or Normal from this menu to display the page. 
 
Full Screen (and entry into Annotations Mode) 
This displays the image using the full-screen.  Please read Image Full-screen Preview / 
Annotations Mode about the available features in that area, including Annotations.  You can also 
double-click the image area to enter full-screen mode. 
 
OCR Page 
This OCRs the current page.  If Auto-rotate is on, the page will be rotated as needed to find the 
best OCR results. 
 
See Keywords 
This shows the keywords tied to the current page.  Use the OCR Page from this menu to fill in 
this form with keywords derived from the OCR results.  Keywords can also be manually entered 
or changed. 
 
Rotate 
This allows you to rotate the current image in Page Image Preview.  You can rotate the page 
right, left, or upside-down (right-click the thumbnail/grid area to see a menu option to rotate a 
multiple pages). 
 
Despeckle (B&W Tiff only) 
This allows you to despeckle the current image in the Page Image Preview.  You have a choice of 
1, 2, or 3 pixel despeckle, which is explained more in the Scanning Options section (right-click the 
thumbnail/grid area to see a menu option to despeckle multiple pages). 
 
Deskew (B&W Tiff only) 
This allows you to deskew the current image in Page Image Preview.   Deskewing attempts to 
straighten a page that is at a slight angle. 
 
WARNING: This option may have undesirable effects on images when it cannot determine how to 
straighten them because of a lack of lines or margins.  Therefore, it is recommended you do this 
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one image at a time, where you can still cancel if the deskew fails to work properly.  Right-click 
the thumbnail/grid area to see a menu option to deskew multiple pages. 
 
Auto-Crop (B&W Tiff only) 
This attempts to determine where the edge of a document image is and eliminates the white 
space outside that region.  This option maybe very useful when images like bank checks were 
scanned and you want to eliminate the unneeded white space. 
 
WARNING: Be careful using this option, as it may cut-off more than you desire if the page does 
not have well defined borders.  If you do not like the result of the auto-crop operation, cancel the 
change by clicking the Cancel button in the Document Image Data Navigator. 
 
Convert Image to B&W Tiff 
This option is for users who may elect to convert the current image from Jpeg or PNG to the 
much more efficient B&W Tiff format (right-click the thumbnail/grid area to see a menu option to 
convert multiple pages). 
 
Cropping Mode 
This option allows you to select a rectangular area and eliminate the area outside the rectangle 
(cropping).  When you finish selecting an area, you will be asked if you want to crop this area.  If 
you do not like the cropping result, cancel the change by clicking the Cancel button in 
the Document Image Data Navigator. 
 
WARNING: Cropping Mode remains active until you click the menu option again. 
 
Help 
This help section is displayed. 
 
Full-screen Image View / Annotations Mode 
To enter full-screen image view, while in the Pages Form double-click the image preview area or 
double click the thumbnail of the desire page you want to see. 

 
In menu order, menu item definitions are as follows: 
 
Proportional 
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This displays the entire image on the full-screen.  This may make the image hard to read, but 
easy to identify what type of page or document it is. 
 
Fit Width 
This fits the width of the image on the full-screen.  You may have to use the vertical scroll bar to 
see the bottom of the page. 
 
Normal 
This displays the image as-is on the full-screen.  If the image size is large, you may only be able 
to see a small section of the page at one time. 
 
Annotations Mode 
This option allows you to mark-up an image without changing the underlying image.  The 
annotations can be printed or ignored as part of the printed page. 
 
The below Annotations Toolbar will be displayed across the top of the full-screen.  

 
 
To add annotations, hover the mouse cursor over the Toolbar button to display a hint about the 
type of annotation.  Click on the desired annotation button and mark-up the image.  Many of the 
annotations also have their own pop-up menu - click the desired annotation on the image 
(typically highlighted using black squares) and right-click to see if any further editing options exist. 
 
To remove an unwanted annotation, click the desired annotation on the image (typically 
highlighted using black squares) and press the <Delete> key. 
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An example of an annotation in a document image. 
 
NOTE: To print a document with annotations, right-click the main screen images preview area 
and make sure Annotations Printing On is checked.  Then you may either print the document with 
annotations from the main screen's image preview area menu or from the document page grid 
menu.   
 
Panning Mode 
This option changes the cursor to a hand.  Holding down the left mouse button allows you to grab 
and move the document to scroll to a different area of the document. 
 
Crop-in and Zoom Mode 
This changes the cursor to a small rectangle.  Click and hold down the left mouse button to draw 
a rectangle around the desired area.  When you release the mouse button, D2M will zoom-in to 
the selected area.  Return to a normal viewing state by selecting Proportional, Fit Width, 
or Normal from the pop-up menu. 
 
Close Preview 
This closes the full-screen preview. 
 
Help 
This help section is displayed. 
 
Ask about File(s) Dialog 
This dialog appears when Docs2Manage (D2M) needs to know how you would like to import a 
file(s) into D2M.  Files can be loaded as either Windows Documents via OLE or as plain files.  For 
further information, please read the Definitions section. 
 

 
Button definitions are as follows: 
 
Add All Docs as Files (recommended):  Loads multiple files into D2M without attempting to 
load/run the document to acquire a preview to be shown in the Page Preview area.  This may be 
the best option when you are trying to load files that are unknown to Windows, like data files. 
 
Add This Doc as File (recommended):  This works like the previous button but only processes 
the current file.  If you are adding multiple documents, the dialog will appear again to ask about 
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the next file. 
 
Add All Docs as Win Docs:  Loads multiple files into D2M by loading the document in the editor 
known to Windows.  Because of this, a preview or icon may show in the Page Preview area. 
 
Add This Doc as Win Doc:  This works like the previous button but only processes the current 
file.  If you are adding multiple documents, the dialog will appear again to ask about the next file. 
 
Update Document Date with File Date Check-box:  If this check-box is checked, the Date of 
Document field (DOCMAIN.DATEOFDOC) will be updated with the date that the imported file was 
last modified. 
 
Cancel:  Stops the operation from this point. 
 
TIP: You can make this a permanent selection by changing the Default Format when Storing 
Non-image Files setting in the D2M Configuration program.  For more information on this issue, 
please read the Default Format when Storing Non-image Files section.  
 
Field Manager Toolbar 
From the File menu, select Field Manager. 
 

 
From left to right, button definitions are as follows: 
 

  Click the Map New button to map any unmapped fields.  Select an unmapped field 
from the Mapped to drop-down list, select a type from the Type of Field drop-down list, and fill in 
the Field Caption with a friendly caption the user will see.  
 

  Click the Delete Mapping button to delete the current field mapping.  If the 
selected field is of drop-down edit type, all the values will also be deleted. 
 

  The New Value button is only active when the current field is a drop-down edit 
field.  This button will insert a new record into the grid on the right side of the screen where the 
drop-down value can be entered. 
 

  The Delete Value button is only active when the current field is a drop-down edit 
field.  This button will delete the record that is currently selected on the grid on the right side of 
the screen.  If the selected value record is the only record in the grid, D2M will warn that the 
deletion of this value will also delete the field mapping. 
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  The Update button is only active when there are unsaved changes to a field.  
Click this button to commit changes. 
 

  The Cancel button is only active when there are unsaved changes to a field.  Click 
this button to cancel pending changes. 
 
Entering Information about Data Fields 
The Field Manager form allows you to customize both existing and new fields used by 
Docs2Manage (D2M).  Please read the Adding and Using Additional User Fields section for 
information on how to add new fields. 
 
From the File menu, select Field Manager. 

   
 
Update Information about a Data Field 
Fields are named by what their current field caption value is and the field's underlying table and 
field name in the database in parenthesis (e.g., Document Folder (DOCMAIN.DOCFOLDER)). 
 
1. Select a field from the Column Search drop-down list.  If you do not find the field you want to 
modify, the field may be unmapped and needs to be mapped before you can update the field 
information (steps 1a - 1c). 
1a. To map an unmapped field, click the Map New button on the Field Manager Toolbar.   
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1b. Select the unmapped field from the Mapped to drop-down edit field and populate the 
remaining fields. 
1c. Click the Update button. 
2. Add or update the appropriate values for the fields listed below: 
 
Mapped to 
For a mapped field, this will display the name of the column you selected above.  Otherwise, 
select from the available list of unmapped fields. 
 
Type of Field 
•  Select Drop-down Edit if you would like the referenced column to have a drop-down list of 

values. 
•  Select Field Edit if you desire a plain edit field or calendar picker if the field is a date field.   

•  Select Hide Field if you want to hide any of the main fields.  If you hide a field, the field must 

not be required in the database table or you will receive an error message from the database. 
•  Select Hide Field in Grid if you want to hide any required fields in the grid.  These fields will 

still be available in the Document Information Form. 
 
Field Caption 
Edit this field to change the field caption or grid label.  The "~" character makes the grid label 
appear on two lines in the grid column header.  Place the character where you want the label's 
new line to begin.  The character can be used only once, since the column header only has room 
for two lines.  The character does not appear in the caption on the form view or search dialog. 
 
Default Value (only displayed for Field Edit type fields) 
This value will be the default value for a new record. 
 
Edit Mask 
This value controls or guides how a user can input data.  This is good if you want to keep the data 
in a format that can consistently be searched in consistent manner.  Edit Mask can be very simple 
or very complex depending on your needs.  Please read the Edit Mask section of this help file to 
understand how to construct an Edit Mask. 
 
Entry is Required 
This field when checked requires the user to at least enter one number or character in the entry 
field.  If they do not, they will not be allowed to post the changes to the database. 
 
Drop-down Edit Value (only displayed in the grid for Drop-down Edit type fields) 
Field values become one of the values in the drop-down edit. 
 
Drop-down Order (only displayed in the grid for Drop-down Edit type fields) 
Drop-down edit values will be listed in alphabetical order by default.  If you would like to 
customize the order of the values, enter numbers indicating your ordering preference.   
 
TIP:  You may want to use numbers like 10, 20, 30... rather than 1, 2, 3...  This will make it easier 
to fit a new value between existing values in the future. 
 
Default Choice on New Record (only displayed in the grid for Drop-down Edit type fields) 
Check this field if you would like the corresponding value to be the default in the Drop-down Edit 
list when a new record is inserted.  
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Edit Mask 
Edit Mask is a string that consists of three fields with semicolons separating them. The first part of 
the mask is the mask itself. The second part is the character that determines whether the literal 
characters of a mask are saved as part of the data. The third part of the mask is the character 
used to represent un-entered or blank characters in the mask. 
 
These are the special characters used in the first field of the mask: 
 
Character Meaning in mask 
 
! If a ! character appears in the mask, optional characters are represented in the text as leading 
blanks. If a ! character is not present, optional characters are represented in the text as trailing 
blanks. 
> If a > character appears in the mask, all characters that follow are in uppercase until the end of 
the mask or until a < character is encountered. 
< If a < character appears in the mask, all characters that follow are in lowercase until the end of 
the mask or until a > character is encountered. 
 
<> If these two characters appear together in a mask, no case checking is done and the data is 
formatted with the case the user uses to enter the data. 
\ The character that follows a \ character is a literal character. Use this character to use any of the 
mask special characters as a literal in the data. 
L The L character requires an alphabetic character only in this position. For the US, this is A-Z, a-
z. 
l The l character permits only an alphabetic character in this position but doesn't require it. 
 
A The A character requires an alphanumeric character only in this position. For the US, this is A-
Z, a-z, 0-9. 
a The a character permits an alphanumeric character in this position, but doesn't require it. 
C The C character requires an arbitrary character in this position. 
c The c character permits an arbitrary character in this position, but doesn't require it. 
0 The 0 character requires a numeric character only in this position. 
9 The 9 character permits a numeric character in this position, but doesn't require it. 
 
# The # character permits a numeric character or a plus or minus sign in this position, but doesn't 
require it. 
: The : character is used to separate hours, minutes, and seconds in times. If the character that 
separates hours, minutes, and seconds is different in the regional settings of the Control Panel 
utility on your computer system, that character is used instead. 
/ The / character is used to separate months, days, and years in dates. If the character that 
separates months, days, and years is different in the regional settings of the Control Panel utility 
on your computer system, that character is used instead. 
 
; The ; character is used to separate the three fields of the mask. 
_ The _ character automatically inserts spaces into the text. When the user enters characters in 
the field, the cursor skips the _ character. 
 
Any character that does not appear in the preceding table can appear in the first part of the mask 
as a literal character. Literal characters must be matched exactly in the edit control. They are 
inserted automatically, and the cursor skips over them during editing. The special mask 
characters can also appear as literal characters if preceded by a backslash character (\). 
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The second field of the mask is a single character that indicates whether literal characters from 
the mask should be included as part of the text for the edit control. For example, the mask for a 
telephone number with area code could be the following string: 
 
(000)_000-0000;0;* 
 
The 0 in the second field indicates that the Text property for the edit control would consist of the 
10 digits that were entered, rather than the 14 characters that make up the telephone number as 
it appears in the edit control. 
 
A 0 in the second field indicates that literals should not be included, any other character indicates 
that they should be included. The character that indicates whether literals should be included can 
be changed in the Edit Mask property editor. 
 
The third field of the mask is the character that appears in the edit control for blanks (characters 
that have not been entered). By default, this is the same as the character that stands for literal 
spaces. The two characters appear the same in an edit window. However, when a user edits the 
text in a masked edit control, the cursor selects each blank character in turn, and skips over the 
space character. 
 
Note: When working with multi-byte character sets, each special mask character represents a 
single byte. To specify multi-byte characters using the L, l, A, a, C, or c specifiers, the mask 
characters must be duplicated as well. For example, LL would represent two single-byte 
alphabetic characters or a one double-byte character. Only single-byte literal characters are 
supported. 
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Chapter 4 – Notes and Credits 
 
Additional Notes 
Docs2Manage was developed by COMvantage Solutions.  We do more than just build and sell 
our own software, we also provide consulting.  We have done many successful projects from 
Database Administration, Client/Server Windows applications, to E-commerce web applications.  
Please visit our website at www.docs2manage.com for more information or forward any request 
or questions to Tom Glunz at tglunz@docs2manage.com 
 
Credits 
Microsoft Windows, MS Paint, SQL Server, Office, Excel, Word, and Access are registered 
trademarks of the Microsoft Corporation 
Oracle Database is a registered trademark of the Oracle Corporation 
Sybase or SAP Adaptive Server  is a registered trademark of the SAP Corporation 
InterBase is a registered trademark of the Embarcadero Corporation 
Firebird is an open source database project 
DB2 Database is a registered trademark of the IBM Corporation 
MySQL open source database is a register trademark of the MySQL AB Company 
Pentium is a registered trademark of the Intel Corporation 
!ntellect and Time and Chaos contact management software is a registered trademark of 
the Chaos Software 
 
The compression and decompression algorithms used in D2M via VCLZip and VCLUnZIp are 
based on the public domain software that makes up the DOS based INFOZIP software written 
mainly by Mark Adler and Jean-Loup Gailly. 
 
I'd also like to thank some of my friends and BETA testers who took time to test and make 
suggestions to improve the product.  Don't worry; you will all be treated to a Gino's East Chicago-
style Pizza. 
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